March 2013

Copyright © 2000—2013 Harmonic Inc. All rights reserved. Omneon, and the Omneon logo are trademarks of Harmonic Inc.

Disclaimer

Harmonic reserves the right to alter the equipment specifications and descriptions in this publication without prior notice. No part of this publication shall be deemed to be part of any contract or warranty unless specifically incorporated by reference into such contract or warranty. The information contained herein is merely descriptive in nature, and does not constitute a binding offer for sale of the product described herein. Harmonic assumes no responsibility or liability arising from the use of the products described herein, except as expressly agreed to in writing by Harmonic. The use and purchase of this product do not convey a license under any patent rights, copyrights, trademark rights, or any intellectual property rights of Harmonic. Nothing hereunder constitutes a representation or warranty that using any products in the manner described herein will not infringe any patents of third parties.

Trademark Acknowledgments

Harmonic and all Harmonic product names are trademarks of Harmonic Inc. All other trademarks are the property of their respective owners.

The software described in this document is furnished under a license agreement or nondisclosure agreement. The software may be used or copied only in accordance with the terms of those agreements.

License Agreement and Limited Warranty

1. AGREEMENT: This is a legal agreement (“Agreement”) between you (“you” or “your”) and Harmonic, or its appropriate local affiliate (“Harmonic”, “we”, “us” or “our”). Use of our product(s) and any updates thereto purchased or validated obtained by you (the “Products”), and/or the Software (as defined below) collectively, the “System”), constitutes your acceptance of this Agreement. “Use” includes opening or breaking the seal on the product containing this Agreement, installing or downloading the Software as defined below or using the Software preloaded or embedded in your System. As used herein, the term “Software” means the Harmonic owned software and/or firmware used in or with the Products and embedded into, provided with or loaded onto the Products in object code format, but does not include, and this Agreement does not address, any third-party or free or open source software separately licensed to you (“Third Party Software”). If you do not agree to this Agreement, you shall promptly return the System with a dated receipt to the seller for a full refund.

2. LICENSE: Subject to the terms and conditions of this Agreement including payments, we hereby grant you a nonexclusive, nontransferable license to use the object code version of the Software embedded into, provided solely for use with or loaded onto the Product, and the accompanying documentation (“Documentation”) for your internal business purposes. The Software and any authorized copies are owned by us or our suppliers, and are protected by law, including without limitation the copyright laws and treaties of the U.S.A. and other countries. Evaluation versions of the Software may be subject to a time-limited license key.

3. RESTRICTIONS: You and your employees and contractors shall not attempt to reverse engineer, disassemble, modify, translate, create derivative works of, rent, lease (including use on a timesharing, applications service provider, service bureau or similar basis), loan, distribute, sublicense or otherwise transfer the System, in whole or part except to the extent otherwise permitted by law. The Software may be operated on a network only if and as permitted by its Documentation. You may make one (1) back up copy of the object code of the Software for archival purposes only. Evaluation Software will be run in a lab, nonproductive environment. Results of any benchmark or other performance tests may not be disclosed to any third party without our prior written consent. Title to and ownership of the Software and Documentation, and all copyright, patent, trade secret, trademark, and other intellectual property rights in the System, shall remain our or our licensors’ property. You shall not remove or alter any copyright or other proprietary rights notice on the System. We reserve all rights not expressly granted.

4. LIMITED WARRANTY: (a) Limited Warranty. We warrant to you that, commencing on your receipt of a Product and terminating 1 year thereafter, the System will perform substantially in accordance with its then-current appropriate Documentation. The Product, including replacements, may consist of new, used or previously-installed components. (b) Remedies. If the System fails to comply with such warranty during such period, as your sole remedy, you must return the same in compliance with our product return policy, and we shall, at our option, repair or replace the System, provide a workaround, or refund the fees you paid. Replacement Systems are warranted for the original System’s remaining warranty period. (c) Exclusions. EVALUATION SOFTWARE IS LICENSED ON AS-IS BASIS AND SUBJECT TO 4(d): We will have no obligation under this limited warranty due to: (i) negligence, misuse or abuse of the System, such as unusual physical or electrical stress, misuse or accidents; (ii) use of the System other than in accordance with the Documentation; (iii) modifications, alterations or repairs to the System made by a party other than us or our representative; (iv) the combination, operation or use of the System with equipment, devices, software or data not supplied by us; (v) any third party hardware or Third Party Software, whether or not provided by us; (vi) any failure other than by us to comply with handling, operating, environmental, storage or maintenance requirements for the System in the Documentation, including, without limitation, temperature or humidity ranges. (d) Disclaimers. We are not responsible for your software, firmware, information, or data contained in, stored on, or integrated with any Product returned to us for repair or replacement. SUCH
LIMITED WARRANTY IS IN LIEU OF, AND WE SPECIFICALLY DISCLAIM, ANY AND ALL OTHER WARRANTIES, WHETHER EXPRESS, IMPLIED OR STATUTORY, INCLUDING, BUT NOT LIMITED TO, ANY IMPLIED WARRANTIES OF SATISFACTORY QUALITY, MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE OR NON-INFRINGEMENT. WE DO NOT WARRANT THAT THE SYSTEM WILL MEET YOUR REQUIREMENTS OR BE UNINTERRUPTED OR ERROR-FREE. NO ADVICE OR INFORMATION, WHETHER ORAL OR WRITTEN, OBTAINED FROM US OR ELSEWHERE, WILL CREATE ANY WARRANTY NOT EXPRESSLY STATED IN THIS AGREEMENT. Some jurisdictions do not allow the exclusion of implied warranties or limitations on the duration of implied warranties, so the above limitations or exclusions may not apply to you. In that event, such implied warranties or limitations are limited to 60 days from the date you purchased the System or the shortest period permitted by applicable law, if longer. This warranty gives you specific legal rights and you may have other rights which vary from state to state or country to country.

5. LIMITATION OF LIABILITY: WE AND OUR AFFILIATES, SUPPLIERS, LICENSORS, OR SALES CHANNELS ("REPRESENTATIVES") SHALL NOT BE LIABLE TO YOU FOR ANY SPECIAL, INCIDENTAL, CONSEQUENTIAL, PUNITIVE, OR EXEMPLARY DAMAGES OF ANY KIND, INCLUDING BUT NOT LIMITED TO LOSS OF REVENUES, PROFITS, OR SAVINGS, OR THE COST OF SUBSTITUTE GOODS, HOWEVER CAUSED, UNDER CONTRACT, TORT, BREACH OF WARRANTY, NEGLIGENCE, OR OTHERWISE, EVEN IF WE WERE ADVISED OF THE POSSIBILITY OF SUCH LOSS OR DAMAGES. NOTWITHSTANDING ANY OTHER PROVISIONS OF THIS AGREEMENT, WE AND OUR REPRESENTATIVES' TOTAL LIABILITY TO YOU ARISING FROM OR RELATING TO THIS AGREEMENT OR THE SYSTEM SHALL BE LIMITED TO THE TOTAL PAYMENTS TO US UNDER THIS AGREEMENT FOR THE SYSTEM. THE FOREGOING LIMITATIONS SHALL NOT APPLY TO DEATH OR PERSONAL INJURY TO PERSONS OR TANGIBLE PROPERTY IN ANY JURISDICTION WHERE APPLICABLE LAW PROHIBITS SUCH LIMITATION. YOU ARE SOLELY RESPONSIBLE FOR BACKING UP YOUR DATA AND FILES, AND HEREBY RELEASE US AND OUR REPRESENTATIVES FROM ANY LIABILITY OR DAMAGES DUE TO THE LOSS OF ANY SUCH DATA OR FILES. SOME JURISDICTIONS DO NOT ALLOW THE EXCLUSION OR LIMITATION OF INCIDENTAL OR CONSEQUENTIAL DAMAGES, SO SUCH EXCLUSIONS MAY NOT APPLY TO YOU.

6. CONFIDENTIALITY: Information in the System and the associated media, as well as the structure, organization and code of the Software, are proprietary to us and contain valuable trade secrets developed or acquired at great expense to us or our suppliers. You shall not disclose to others or utilize any such information except as expressly provided herein, except for information (i) lawfully received by the user from a third party which is not subject to confidentiality obligations; (ii) generally available to the public without breach of this Agreement; (iii) lawfully known to the user prior to its receipt of the System; or (iv) required by law to be disclosed.

7. SUPPORT: Updates, upgrades, fixes, maintenance or support for the System (an "Upgrade") after the limited warranty period may be available at separate terms and fees from us. Any Upgrade shall be subject to this Agreement, except for additional or inconsistent terms we specify. Upgrades do not extend the limited warranty period.

8. TERM; TERMINATION: The term of this Agreement shall continue unless terminated in accordance with this Section. We may terminate this Agreement at any time upon default by you of the license provisions of this Agreement, or any other material default by you of this Agreement not cured within ten (10) days after written notice thereof. You may terminate this Agreement at any time by terminating use of the System. Except for the first sentence of Section 2 ("License") and for Section 4(a) ("Limited Warranty"), all provisions of this Agreement shall survive termination of this Agreement. Upon any such termination, you shall certify in writing such termination and non-use to us.

9. EXPORT CONTROL: You agree that the Products and Software will not be shipped, transferred, or exported into any country or used in any manner prohibited by the United States Export Administration Act or any other export laws, restrictions, or regulations (the "Export Laws"). You will indemnify, defend and hold us harmless from any and all claims arising herefrom or relating thereto. In addition, if the Products or Software are identified as export controlled items under the Export Laws, you represent and warrant that you are not a citizen or otherwise located within, an embargoed nation (including without limitation Iran, Iraq, Syria, Sudan, Libya, Cuba, North Korea, and Serbia) and that you are not otherwise prohibited under the Export Laws from receiving the Software. All rights to the Products and Software are granted on condition that such rights are forfeited if you fail to comply with the terms of this Agreement.

10. U.S. GOVERNMENT RIGHTS: The Software and the documentation which accompanies the Software are "Commercial Items," as that term is defined at 48 C.F.R. §2.101, consisting of "Commercial Computer Software" and "Commercial Computer Software Documentation," as such terms are used in 48 C.F.R. §2.212 or 48 C.F.R. §227.7202, as applicable. Consistent with 48 C.F.R. §2.212 or 48 C.F.R. §§227.7202-1 through 227.7202-4, as applicable, the Commercial Computer Software and Commercial Computer Software Documentation are being licensed to U.S. Government as end users (a) only as Commercial Items and (b) with only those rights as are granted to all other end users pursuant to the terms and conditions herein. Harmonic, 4300 North First Street, San Jose, CA 95134 U.S.A.

11. GENERAL: You shall not assign, delegate or sublicense your rights or obligations under this Agreement, by operation of law or otherwise, without our prior written consent, and any attempt without such consent shall be void. Subject to the preceding sentence, this Agreement binds and benefits permitted successors and assigns. This Agreement is governed by California law, without regard to its conflicts of law principles. The U.N. Convention on Contracts for the International Sale of Goods is disclaimed. If any claim arises out of this Agreement, the parties hereby submit to the exclusive jurisdiction and venue of the federal and state courts located in Santa Clara County, California. In addition to any other rights or remedies, we shall be entitled to injunctive and other equitable relief, without posting bond or other security, to prevent any material breach of this Agreement. We may change the terms, conditions and pricing relating to the future licensing of our Systems and other intellectual property rights, including this Agreement, from time to time. No waiver will be implied from conduct or failure to enforce rights nor effective unless in a writing signed on behalf of the party against whom the waiver is asserted. If any part of this Agreement is found unenforceable, the remaining parts will be enforced to the maximum extent permitted. There are no third-party beneficiaries to this Agreement. We are not bound by additional and/or conflicting provisions in any order, acceptance, or other correspondence unless we expressly agree in writing. This Agreement is the complete and exclusive statement of agreement between the parties as to its subject matter and supersedes all proposals or prior agreements, verbal or written, advertising, representations or communications concerning the System.

Every reasonable attempt has been made to comply with all licensing requirements for all components used in the system. Any oversight is unintentional and will be remedied if brought to the attention of Harmonic at support@harmonicinc.com.
Documentation Conventions

This guide may use some special symbols and fonts to call your attention to important information. The following symbols appear throughout this guide:

- **DANGER:** The Danger symbol calls your attention to information that, if ignored, can cause physical harm to you.

- **CAUTION:** The Caution symbol calls your attention to information that, if ignored, can adversely affect the performance of your Harmonic product, or that can make a procedure needlessly difficult.

- **LASER DANGER:** The Laser symbol and the Danger alert call your attention to information about the lasers in this product that, if ignored, can cause physical harm to you.

- **NOTE:** The Note symbol calls your attention to additional information that you will benefit from heeding. It may be used to call attention to an especially important piece of information you need, or it may provide additional information that applies in only some carefully delineated circumstances.

- **IMPORTANT:** The Important symbol calls your attention to information that should stand out when you are reading product details and procedural information.

- **TIP:** The Tip symbol calls your attention to parenthetical information that is not necessary for performing a given procedure, but which, if followed, might make the procedure or its subsequent steps easier, smoother, or more efficient.

In addition to these symbols, this guide may use the following text conventions:

<table>
<thead>
<tr>
<th>Convention</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Typed Command</td>
<td>Indicates the text that you type in at the keyboard prompt.</td>
</tr>
<tr>
<td>&lt;Ctrl&gt;, &lt;Ctrl&gt;+&lt;Shift&gt;</td>
<td>A key or key sequence to press.</td>
</tr>
<tr>
<td>Links</td>
<td>The <em>italics in blue</em> text to indicate Cross-references, and hyperlinked cross-references in online documents.</td>
</tr>
<tr>
<td>Bold</td>
<td>Indicates a button to click, or a menu item to select.</td>
</tr>
<tr>
<td>ScreenOutput</td>
<td>The text that is displayed on a computer screen.</td>
</tr>
<tr>
<td>Emphasis</td>
<td>The <em>italics</em> text used for emphasis and document references.</td>
</tr>
</tbody>
</table>

**NOTE:** You require Adobe Reader or Adobe Acrobat version 6.0 or later to open the PDF files. You can download Adobe Reader free of charge from www.adobe.com.
Table of Contents

Chapter 1: Introduction .................................................................................. 7
  New in this Release .................................................................................. 7

Chapter 2: Installing ClipTool Pro .................................................................. 8
  System Requirements ................................................................................ 8
  System Compatibility .............................................................................. 8
  What Gets Installed. ................................................................................ 8
  ClipTool Pro Installation ........................................................................ 8
  ClipTool Pro Licensing .......................................................................... 9

Chapter 3: Using ClipTool Pro ...................................................................... 11
  Launching ClipTool Pro .......................................................................... 11
  Adding a Customized ClipTool Pro Shortcut on your Desktop ................. 12
  ClipTool Pro Main Window Orientation ................................................ 13
  Clip Status Area .................................................................................... 14
  Menu Bar ................................................................................................ 15
  Clip Management Area ......................................................................... 21
  Loading Clips for Playback ..................................................................... 22
  Deleting Clips ....................................................................................... 23
  Renaming Clips ...................................................................................... 24
  Copying Clips ......................................................................................... 24
  Recording Clips ...................................................................................... 25
  Performing a Crash Record .................................................................... 26
  Recording a Loop ................................................................................... 26
  Playout while Recording ....................................................................... 27
  Merging Clips ......................................................................................... 28
  Editing Clips Prior to Merging ............................................................... 29
  Clip Dubbing .......................................................................................... 29
  Introduction to Clip Dubbing .................................................................. 29
  Clip Dubbing Operations ....................................................................... 31
  Clip Dubbing Restrictions ..................................................................... 34
  Saving and Opening Playlists ................................................................. 35
  Changing Default Settings for New Clips and the Clip List ...................... 35
  ClipTool Pro Keyboard Shortcuts ............................................................ 36

Appendix A: Contacting the Technical Assistance Center .........................37

Appendix B: Compliance, Safety, and Agency Approvals .............................39
  WEEE/RoHS Compliance Policy .............................................................. 39
  Restricted Substance Statement ............................................................. 40
  Names and Contents of Toxic and Hazardous Substances ....................... 40
  Standards and Agency Approval .............................................................. 42
<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Canadian EMC Notice of Compliance</td>
<td>42</td>
</tr>
<tr>
<td>Important Safeguards and Notices</td>
<td>52</td>
</tr>
<tr>
<td>Safety and Regulatory Information for the</td>
<td></td>
</tr>
<tr>
<td>ContentServer 3000 and ContentStore 3160</td>
<td>52</td>
</tr>
<tr>
<td>Lithium Battery Notice for Service Personnel</td>
<td>53</td>
</tr>
<tr>
<td>Safety Symbols</td>
<td>55</td>
</tr>
<tr>
<td>Safety Precautions</td>
<td>56</td>
</tr>
<tr>
<td>AC Power Supply to the Unit</td>
<td>56</td>
</tr>
<tr>
<td>DC Power Supply to the Unit</td>
<td>57</td>
</tr>
<tr>
<td>Rack Mount Instructions</td>
<td>57</td>
</tr>
<tr>
<td>Handling Fibre Channel Cables</td>
<td>57</td>
</tr>
<tr>
<td>Product End-of-Life Disassembly Instructions</td>
<td>58</td>
</tr>
<tr>
<td>Safety Rules</td>
<td>60</td>
</tr>
</tbody>
</table>
Chapter 1
Introduction

ClipTool Pro Release 3.2 is an application that allows you to monitor and control Players. It provides four basic categories of clip control:

- **Transport Control Functions** (such as Play, Stop, Record, Crash Record, Loop Record, and Shuttle)
- **Clip Management Functions** (such as Create Clip, Delete Clip, and View Clip List)
- **Display Functions** (such as displaying frame count, timecode, and Player status)
- **Editing Functions** (such as Mark In, Mark Out, Clear Marks, and Merge Timeline)

You can install and launch ClipTool Pro on any computer running Windows® 2000 or Windows XP that has TCP/IP connectivity to the SystemManager and MediaDirector. ClipTool Pro is compatible with Spectrum System software v4.6SR2 (Service Release 2) or higher.

ClipTool Pro can monitor any Player’s operation, and manually control the Players through a VTR-like control panel. Players do not need to have ClipTools running for them to work. (Automation systems can control Players, for example.) If you exit from ClipTool Pro or start a new instance of the application, it does not affect the Player; only explicit actions do.

The guide provides installation and operating instructions for ClipTool Pro in the following sections:

- **Installing ClipTool Pro**
- **Using ClipTool Pro**

**New in this Release**

This release of the software includes the following enhancements:

- **Added Display of Available Recording Time**
  When recording a clip, the blue bar gauge, which displays the amount of storage available, now displays the amount of time remaining, rounded to the nearest 0.25 of an hour. For details, refer to **Clip Management Area**.

- **Changes to the 'Type or Select a Directory' Dialog Box**
  The dialog box used for selecting a working directory now allows you to select a directory from an expandable directory structure. For details, refer to **Menu Bar**.

- **Added Initialization File for Changing Default Settings for New Clips and Clip List**
  An added initialization file now allows you to specify default settings for recording new clips or to display currently loaded clips in the Clip List window upon start-up. For details, refer to **Changing Default Settings for New Clips and the Clip List**.
Chapter 2
Installing ClipTool Pro

This section provides installation instructions for ClipTool Pro—a product in Harmonic’s line of MediaTools. The following topics are covered:

- **System Requirements**
- **System Compatibility**
- **What Gets Installed**
- **ClipTool Pro Installation**
- **ClipTool Pro Licensing**

## System Requirements

Prior to installing ClipTool Pro, your PC must conform to the following minimum requirements, and must be connected via Ethernet to your facility’s LAN:

- 2.4 GHz Pentium 4 or equivalent CPU
- 256 megabytes (MB) of RAM
- 20 GB hard drive
- At least 3 Megabytes of free disk space
- Windows 2000 Service Pack 3 (SP3) or later, or Windows XP
- Display resolution should be set to 1024 x 768 *minimum*
- 100 BaseT (Gigabit Ethernet recommended)

## System Compatibility

ClipTool Pro is compatible with Harmonic Spectrum System software v4.6SR2 (Service Release 2) or higher.

## What Gets Installed

The application consists of the main ClipTool Pro executable plus a PDF version of this guide.

## ClipTool Pro Installation

**NOTE:** Using ClipTool Pro on the SystemManager PC may affect the system performance of the SystemManager software and the ClipTool Pro application. It is recommended that you install ClipTool Pro on a different PC.

1. If you have not already done so, open the **ClipTool Pro.zip** folder that you downloaded from the Harmonic support Web site, and extract the files using the password provided by Technical Support. Contact Technical Support for assistance.
2. Locate the **ClipTool Pro** executable file icon.
3. Double-click the **ClipTool Pro** icon to begin the installation.

4. Click **Next** and then follow the installation steps to install ClipTool Pro.

Refer to *Launching ClipTool Pro* to begin using ClipTool Pro.

**ClipTool Pro Licensing**

A license file (provided by Harmonic) supplies the licenses for the ClipTool Pro components. This file is installed on the Harmonic SystemManager computer.

One license is required for each instance of ClipTool Pro that is in use. These are “floating licenses” so any connected computer can run the application, until the total number of purchased (and licensed) copies are active.

For example: If you have purchased four ClipTool Pro licenses and you have installed the product on 20 computers, you can run up to four instances of ClipTool Pro at any one time. The remaining 16 installations cannot run the tool until one of the first four exits.

A variety of dialogs may appear at startup time if the application encounters licensing issues (for example, the license server is down, the license file cannot be found, all licenses are used, etc.). The figure below shows examples of some of the possible messages you may encounter.
Follow the directions in these dialogs and/or contact your Network Administrator as required to resolve any issues that arise. Contact Harmonic Sales to purchase additional licenses.
Chapter 3
Using ClipTool Pro

This section covers the operation of the Harmonic ClipTool Pro application. Choose from the following topics:

- Launching ClipTool Pro
- ClipTool Pro Main Window Orientation
- Loading Clips for Playback
- Deleting Clips
- Renaming Clips
- Copying Clips
- Recording Clips
- Playout while Recording
- Merging Clips
- Clip Dubbing
- Saving and Opening Playlists
- Changing Default Settings for New Clips and the Clip List
- ClipTool Pro Keyboard Shortcuts

NOTE: ClipTool Pro Version 3.1 can be installed on any PC that is connected to the MediaDirector and SystemManager via TCP/IP. ClipTool Pro is compatible with Harmonic Spectrum System software v4.6SR2 (Service Release 2) or higher. See for installation instructions.

Launching ClipTool Pro

ClipTool Pro Version 3.1 must be assigned to a specific MediaDirector host and a specific Player. You can run multiple ClipTools simultaneously on a PC, but a new ClipTool Pro Version 3.1 window is required for each Player.

Keep the following important points in mind:

- If you launch ClipTool Pro Version 3.1 by clicking the Open Hyperlink on the Player List (in the SystemManager application), the MediaDirector/Player dialog box is bypassed. This occurs because on the Player List, you are by default selecting a valid Player that is already attached to a MediaDirector.

- If this is the first time that you click the Open hyperlink, you will see a dialog box similar to the installation dialog box. Choose the Open this file from this location button, clear the Always Ask check box, and click OK. This procedure will not need to be repeated again.

To launch ClipTool Pro Version 3.1:

1. Ensure that ClipTool Pro Version 3.1 is properly installed. See for installation instructions.
2. Ensure that audio and video sources (and monitors) are connected to each MediaPort.
3. Launch ClipTool Pro by double-clicking the ClipTool Pro desktop icon or by selecting Start > All Programs > Harmonic > Clip Tool Pro.
When no MediaDirector is specified, or when the specified MediaDirector cannot be contacted, the MediaDirector/Player dialog box appears, as shown below.

When the MediaDirector host is known, the MediaDirector Name field is filled in, the Players on that MediaDirector host are automatically listed and the focus is set to the Available Players box. If you have previously used other MediaDirectors, click the drop-down list box to choose a different one.

4. In the MediaDirector Name field, type the current name, DNS name or IP address of the desired MediaDirector host. To check a MediaDirector host’s current name, click the Configuration tab in the SystemManager application. The name appears beside the small MediaDirector icon.

NOTE: Your system can have multiple MediaDirectors. ClipTool Pro must be associated with a MediaDirector host before it can be linked to a Player on that host.

5. With the MediaDirector host name entered, click the List Players button (you can also press Tab or Enter). The label “Searching” appears, after which the list of all active players for the selected MediaDirector host appears in the Available Players box.

If only one active Player exists, it is selected automatically and the dialog box closes (as if OK had been pressed).

6. With multiple Players listed, highlight a Player in the list and click OK (or press Enter). Arrow keys move the highlight from one Player to the next.

NOTE: If required, click Cancel (or press Esc) to cancel the selection of a MediaDirector and Player, and close the ClipTool Pro application.

Once a MediaDirector host and Player have been selected, the dialog box closes and the main ClipTool Pro window appears. Refer to ClipTool Pro Main Window Orientation to continue.

Adding a Customized ClipTool Pro Shortcut on your Desktop

This procedure allows you to place a convenient ClipTool Pro icon (shortcut) on the desktop, which when clicked, loads the application and calls a specific Player and MediaDirector host. This method bypasses the MediaDirector/Player dialog box.

1. Ensure that ClipTool Pro is properly installed. See for installation instructions.

2. Run the Windows "Notepad" application (Start > Programs > Accessories > Notepad).

3. Type the name (or IP address) of the target MediaDirector host and Player on a single line, separated by a colon. For example:
   DIR01046:Sun_Play

4. On the Notepad Menu Bar, click File > Save As to display the Save As dialog box.

5. In the Save As dialog box, click the Desktop icon in the left-hand column.

6. In the File Name field, type a name for this ClipTool Pro’s shortcut, followed by the “.player” extension. For example:
Sun_Play.player

7. Click Save. This places a shortcut on the desktop.
8. Close Notepad by clicking the X, or by clicking File > Exit.

When the shortcut is double-clicked, the application opens with the specified MediaDirector host and Player. To edit the shortcut, right-click the shortcut on the desktop, then click Open With > Notepad. This launches the Notepad application and allows you to change the shortcut’s attributes.

**NOTE:** When using non-English character sets, you should save the file as UTF-8.

The previous procedure uses the default clip directory, as set in the SystemManager on the Edit Player screen (in the Default Clip Directory field). If you want to override the default clip directory in the ClipTool Pro shortcut, and enter a different “specific” clip directory, add the directory’s name to the “.player” file (as created above in step 3). For example:

```
DIR01046:Sun_Play/fs1/news.dir
```

This shortcut, when placed on the desktop, opens the Player “Sun_Play” on MediaDirector DIR01046, and specifically selects the “news.dir” directory on the “fs1” filesystem, for use with all new and previous clips.

**ClipTool Pro Main Window Orientation**

The figure below illustrates two sample ClipTool Pro **Main Windows**—one with the playlist hidden and the other with the playlist visible.

The **Main Window** is a scalable control panel with two different views. By clicking the List button, the **Clip List Window** is alternately shown or hidden. The **Clip List Window** contains this Player’s playlist, with the current active clip indicated by a green arrow. See **Loading Clips for Playback** for instructions on loading clips.
Within the **Main Window**, VTR-style controls are labeled for clarity, and all controls have ToolTips that display when you place your mouse over the control. The ToolTips describe the control’s function, and list any keyboard shortcuts that are *not* already indicated by the GUI (Graphical User Interface). For example, if you place your mouse over the **Stop** button, **Alt+S** is not shown as a ToolTip. This occurs because the underlined **S** in the **Stop** button’s label indicates that pressing **Alt+S** is the keyboard shortcut for the **Stop** button. The ToolTip **Shift+Space** is shown because the GUI does not provide this label.

Several fields in the **Main Window** are **time** fields (**Duration**, **In-point**, **Out-point**, and **Position**). They display time either as raw frame counts or as timecode — depending on a user setting. The blue “**Gas Gauge**” above the **Clip List Window** indicates the amount of storage remaining on the MediaStore. The gauge turns red when there is less than 5 percent of free space remaining.

ClipTool Pro is arranged into four different groups of controls and displays. From top to bottom, these are the **Clip Status Area**, the **Editing Area**, the **Transport Controls**, and the **Clip Management Area**.

### Clip Status Area

The figure below illustrates a sample **Clip Status Area**.

![Clip Status Area](image)

The **Clip Status** area is provided for information, allowing you to obtain quick status on the current Player, MediaDirector and Clip. The following areas are included:

- **Title Bar** — Lists the Player name, the selected MediaDirector and the current directory from which clips will be loaded, and the application name (ClipTool Pro). The directory is also the one in which new clips will be saved.
- **Menu Bar** — Provides four function menus: **File**, **Tools**, **Setup**, **Help**. See **Menu Bar** for details.
- **Clip (Name)** — This field lists the name of the current active clip.
- **Duration** — This field shows the specified duration of the current clip. Note the following:
  - When recording a clip, the **Duration** is the limiting length for the clip, as specified when the clip was created — it is not the current amount on disk.
  - When a recording is stopped, the **Duration** is adjusted to be equal to the amount recorded.
  - When playing back a recorded clip, this field shows the **Duration** between the clip’s in-point and out-point — if any have been set.

  This readout is affected by the **Timecode**, **Time Count**, or **Frame Count** selections in the **Setup** menu. See **Menu Bar** for details on the **Setup** menu.

### Menu Bar

This section discusses the four **Menu Bar** headings and their associated functions.

#### File Menu

1. Click **File** to display the **File** menu as shown below.
2. Click Open Playlist to browse to and open an XML file containing a playlist. See Saving and Opening Playlists for instructions on opening playlists.

3. Click Save Playlist to save the current playlist as an XML file. See Saving and Opening Playlists for instructions on saving playlists.

4. Click New Clip to open the New Clip dialog box. See Recording Clips for instructions on recording new clips.

5. Click Load Clips to open the Load Clips dialog box. See Loading Clips for Playback for instructions on loading clips.

6. Click Eject to eject the selected clips in the playlist. You can eject a clip while another clip is playing. You can also select multiple clips to eject at one time.

7. Click Change Current Directory to display the Type or Select a Directory dialog box, a sample of which is shown in the figure below.

![Type or Select a Directory dialog box](image)

To change directories, type the desired directory name in the Current Working Directory field, or select the directory from the expandable directory structure.

**NOTE:** The directory that appears by default depends on the entry in the Default Clip Directory field on the Player’s Edit Player screen. Refer to the Harmonic SystemManager User’s Guide for more information.

**IMPORTANT:** Changing the Player’s Clip Directory using ClipTool Pro will not affect the Clip Directory that is used by other ClipTools, nor will it affect the Clip Directory used by control applications (for example, VDCP, OmniBus, BVW, etc.).
8. Click **Dubbing** to initiate the clip dubbing procedure, and display the **Choose Recording MediaDirector/Player** dialog box. See *Clip Dubbing* for instructions.

9. Click **Save Loop** once you have recorded a loop and want to save it. This menu item is only active if a loop has been recorded. See *Recording a Loop* for instructions.

10. Click **Exit** to exit the ClipTool Pro application.

**Tools Menu**

1. Click **Tools** to display the **Tools** menu, as shown below.

![Tools Menu](image)

2. Click **Rename Clip** to change the name of the currently active clip.

3. Click **Player Properties** to display the Player frame rate and its current capabilities.

4. Click **Copy Clip** to copy and save a section of a clip. Refer to *Copying Clips* for instructions on copying clips.

5. Click **Loop Record** to start a Loop Record. Refer to *Recording a Loop* for instructions.

6. Click **Crash Record Options** to change the default name used for the Crash Record. Refer to *Performing a Crash Record* for instructions on Crash Recording.

7. Click **Merge Timeline** to create a single clip out of the current list of clips or subclips. Refer to *Merging Clips* for instructions.

**Setup Menu**

1. Click **Setup** to display the **Setup** menu, as shown below.

![Setup Menu](image)
2. Select **Monitor Only** to gray out all controls. This special view-only mode is designed for situations in which you (or others) want to monitor clip activity (such as with an automation system), but also want to prevent accidental clip control. To return to full control, simply clear the option.

3. Click **Speed Knob Snaps Back** to cause the **Speed Knob** to always snap back to 0 (zero) when it is released.

4. Click **Speed Knob Holds Setting** to cause the **Speed Knob** to remain at its current position (and speed) when it is released. See *Editing Area* for details on the **Speed Knob**.

5. Click **Timecode Readouts** to cause all time-related fields and readouts in the application to display the internal timecode of a clip.

6. Click **Time Count Readouts** to cause all time-related fields and readouts in the application to display a relative time count in which the starting point of a clip is always zero.

7. Click **Frame Count Readouts** to cause all time-related fields and readouts in the application to display frame counts.

8. **Show NTSC Times as DF**. If this grayed-out menu item is indicated with a dot, then the active clip is in Drop Frame format.

9. **Show NTSC Times as NDF**. If this grayed-out menu item is indicated with a dot, then the active clip is in Non Drop Frame format.

10. Click **Up=Prev, Down=Next** to change the behavior of the keyboard’s ARROW keys:
    a. **UP ARROW** — Press to select the previous clip in the clip list window. Pressing **Up Arrow** does not change the position of the player.
    b. **DOWN ARROW** — Press to select the subsequent clip in the clip list window. Pressing **Down Arrow** does not change the position of the player.

11. Click **Up=Play, Down=Pause** to change the behavior of the keyboard’s ARROW keys:
    a. **UP ARROW** — Press to play the current clip in the list.
    b. **DOWN ARROW** — Press to pause the current clip in the list.

**Help Menu**

1. Click **Help** to display the **Help** menu as follows.

   ![Help Menu](image)

   1. Click **Show Help** to open the PDF version of the user’s guide.
   2. Click **About ClipTool Pro** to display the **About ClipTool Pro** dialog box, which provides the current version and copyright information.

**Editing Area**

The figure below illustrates the **Editing Area**.

![Editing Area](image)
Just below the **Clip Status Area**, the **Editing Area** provides tools for marking and trimming clips. On the left-hand side, controls are grouped that affect the clip’s in-point. On the right-hand side, controls affect the clip’s out-point. The following controls are included:

- **Mark [In], Mark [Out]** — These two buttons set the clip’s in-point and out-point — the starting and ending frames for clip playback. Clicking a **Mark** button sets that point on the clip’s current frame. Both the in-point and out-point are *inclusive*; the frames thus marked are the first and last frames to be shown during clip playback.

  **NOTE:** By contrast, in some editing applications, the out-point is *exclusive* — that is, the first frame *not* to be shown. Older linear editors worked this way, but many newer non-linear editors use inclusive out points.

- **Clear [In], Clear [Out]** — Clicking a **Clear** button clears the corresponding marked point. Please note:
  - When no in-point is set, the default in-point is the first frame of the clip and the corresponding **Clear** button is grayed out and disabled.
  - When no out-point is set, the default out-point is the last frame of the clip and the corresponding **Clear** button is grayed out and disabled.
  - The **Time Fields** below the **Mark** and **Clear** buttons show the clip’s current in-point and out-point. These fields are affected by the **Timecode**, **Time Count**, and **Frame Count** selections in the **Setup** menu.

    Refer to **Menu Bar** for details on the **Setup** menu.

- **[Goto] In, Out** — Click the **In** or **Out** button (adjacent to the **Speed Knob**) to jump to the current in-point or out-point, respectively.

- **[Goto] In and Out Timefields** — Edit the timefields below the In or Out buttons to change the current in-point or out-point. You can also double-click the In or Out Timefields, type + or - and then type the number of time units or frames you wish to change.

- **Speed Knob** — Click and drag the **Speed Knob** to adjust playback speed to any of the following multiples of real time:
  -32, -16, -8, -4, -2, -1, -1/2, -1/4, -1/16, -1/32, 0, 1/32, 1/16, 1/8, 1/4, 1/2, 1, 2, 4, 8, 16, 32.

  As you click and drag the knob, the **Transport Status** fields update with the new speed. By default, the **Speed Knob** snaps back to zero when released, but it can be set to hold its current setting through the **Setup** menu. The **Speed Knob** also serves as an indicator — it moves to reflect the speed that is set using other ClipTool Pro commands.

    Refer to **Menu Bar** for details on the **Setup** menu.

- **Timeline** — The **Timeline** represents the current “selected area” within the clip — the area between the default (or marked) in-point and out-point. The **Timeline’s** handle indicates the point of playback; it moves along its track as the clip progresses. Dragging the handle moves the current clip position. The **Timeline** dynamically adjusts so that the current in-point is always at the left-most limit and the current out-point is at the right-most limit.

**Transport Controls**

The figure below illustrates a sample **Transport Control** area.
The transport controls comprise the VTR-style buttons and readouts. Note that most transport controls are grayed-out when no clips are loaded.

The following controls are included:

- **Transport Status** — This readout displays the current transport status. Depending upon the current ClipTool Pro mode, the following “status” labels are shown:
  - Rewind (-32x to –2x)
  - Reverse Play (-1x)
  - Slow Reverse Play (-1/2x to -1/32x)
  - Paused (0x, still frame shown)
  - Stopped (0x, E-E mode)
  - Slow Forward Play (1/32x to 1/2x)
  - Play (1x)
  - Fast Forward (2x to 32x)
  - RECORDING (Shown when recording is in progress)
  - Cued for Record — Shown when the transport is in the appropriate cued status. This mode is the state set by ClipTool Pro when a new clip is created, allowing recording to start immediately.
  - Cued for Play — Shown when the transport is in the appropriate cued status. This mode is usually not seen, except when it is set up by another control program, or when ClipTool Pro is preparing to dub the timeline.

- **Transport Speed** — This readout (to the right of Transport Status) shows the current playback speed, from “–32 x” to “32 x.”

- **Clip Position** — This readout shows the current frame of the current clip (the frame at the handle’s current location). This readout is affected by the Timecode, Time Count, and Frame Count selections in the Setup menu. Refer to Menu Bar for details on the Setup menu. The Clip Position field can be used in the following ways:
  - To cue a timecode, click in the Clip Position field, type a timecode and then press Enter. If the display mode is in Frames, type the frame count and then press Enter.
  - To jump forward or backward in a clip, double-click in the Clip Position field, type the value you wish to jump to, and then press Enter.

**NOTE:** When the display mode is set to either Timecode or Time Count, the field separators are added automatically. For example, 1000 = 10:00 (ten seconds). When the display mode is set to Frame Count, then the default input is frames. For example, 1000 = 1000 frames.

- **Shuttle** buttons — The following transport speeds are supported, as multiples of normal forward play: -32, -16, -8, -4, -2, -1, -1/2, -1/4, -1/16, -1/32, 0, 1/32, 1/16, 1/8, 1/4, 1/2, 1, 2, 4, 8, 16, 32.
  - Clicking the left Shuttle button changes the Clip’s current speed to the next faster reverse speed.
Clicking the right **Shuttle** button changes the Clip’s current speed to the next faster **forward** speed.

Clicking a **Shuttle** control while the Player is stopped plays the Clip at –1/32x or 1/32x, respectively.

- **REW** — (Rewind) Plays the clip at –32x.
- **REV** — (Reverse) Plays the clip at –1x.
- **PAUSE** — Plays (pauses) the clip at 0x, presenting a still frame. If no clip is loaded, black is played.
- **PLAY** — Plays the clip at 1x (normal play mode).

**IMPORTANT:** Clips can only be played back using a Player that has the same configuration as the Player that was originally used for content recording. For example, if a clip was recorded using a DV25 Player, a DV25 “playback” Player must be used to play it out. Note that DV and DVCPRO clips can be played back-to-back because they both use a 25Mbps bitrate.

- **FFWD** — (Fast Forward) Plays the clip at 32x.
- **REC** — (Record) Records a new clip at 1.0x.

**NOTE:** The three readouts (Transport Status, Transport Speed, and Clip Position) display white text on a red background while recording is in progress. The Transport Status field flashes.

- **JOG** buttons — Pauses any playback in progress, and backs up (left **JOG** button) or advances (right **JOG** button) the clip by one frame.
- **STOP** — Stops the playback or recording of a clip, leaving the Player in E-E mode.
- **BOUNCE** — Select the **Bounce** check box to repeatedly play a clip from its IN point and OUT point and then back again. In this mode, the clip reverses when it reaches its OUT point, playing back and forth. Select the **PLAY** button to play the clip. The clip plays continuously until **Stop** is clicked.

**NOTE:** Bounce mode works only with DV clips. It does not work with MPEG I-frame or Long GOP clips.

- **Loop** — Select the **Loop** check box to cause the playlist to restart upon reaching its end, in either direction. In this mode, the clip plays continuously until **Stop** is clicked. Inactive clips (not shown in red) can be selected and moved while the player is in Loop mode. Note that the Player must be stopped before the Loop mode can be activated. See **Recording a Loop** for instructions on setting up a continuous loop recording.

**Clip Management Area**

The figure below illustrates a sample **Clip Management Area**.
The four **Clip Management** buttons allow you to list clips, load clips, eject clips and create new clips for recording. The following controls are included:

- **List** — Click to alternately show and hide the playlist (within the **Clip List Window**). A small triangle on the button itself points **down** when the playlist is hidden or **up** when the playlist is shown, to indicate the “next window action” when the button is pushed.

- **Load** — Click to open the **Load Clips** dialog box. Refer to *Loading Clips for Playback* for instructions on loading clips.

- **New** — Click to open the **New Clip** dialog box. Refer to *Recording Clips* for instructions on recording new clips.

- **Eject** — Click to eject the selected clip(s) in the playlist. You can eject a clip while another clip is playing. You can also select multiple clips to eject at one time. To select multiple clips:
  - Hold down **Shift** and click to select a continuous range.
  - Hold down **Ctrl** and click to select a discontinuous range.
  - Press **Ctrl + Shift** to eject all clips.

The blue **“Gas Gauge”** above the **Clip List Window** represents the amount of storage remaining on the MediaStore. The gauge turns red when there is less than 5 percent of free space remaining. The gauge displays the amount of time remaining using the current parameters for the player/recorder in use. This value is rounded to the nearest 0.25 of an hour.

The **Clip List Window** (when open) shows the clips on the Player’s playlist. This list of clips is also referred to as a “timeline.” The **Clip List Window** can be scaled to show a larger list than the default view. The current active clip is indicated with a green arrow.

Double-click to select a clip. When a clip is selected, you can press **Enter** to begin playing the clip. If a clip is playing or within 5 seconds of being played, the title of that clip will appear in red text, as shown in the following figure.
You can change the order of clips in the Clip List Window by dragging and dropping individual clips.

NOTE: Clips cannot be dragged and dropped or ejected while they are playing or appear in red text.

The status message below the Clip List Window indicates the number of clips that have been loaded and shows whether an error has occurred in loading the clip(s). The following section provides more information about loading clips.

NOTE: To modify the default settings for displaying currently loaded clips in the Clip List window, refer to Changing Default Settings for New Clips and the Clip List.

Loading Clips for Playback

Click the Load button in the Clip Management Area (or click File > Load Clip) to display the Load Clips dialog box, a sample of which is shown below.

The Load Clips dialog box displays a scrollable, multi-column list of clips in the filesystem. You can scale the Load Clips window, or resize the columns by clicking and dragging the boundary between the column headers. Click any of the columns to sort the clips based on what you clicked.

- The Clip Name column shows the clip’s name.
- The Duration column shows the total clip length (regardless of stored in and out-points).
- The Rate column shows the clip’s frame rate.
- The Format column shows how many video and how many separate audio channels are recorded, followed by a list of up to six separate channels’ worth of information (such as the selected video format and any associated audio or VBI channels).

The list is arranged in alphabetical order and shows all clips in the current directory (not just the clips that can be loaded in this ClipTool’s player). By listing all clips, you can easily see what names have been used (and if desired, what clips you want to delete).

Several methods are available to select clips:

- Use the Arrow keys to move the highlight, or simply click the mouse on the desired clip.
- Hold down Shift and click to select a continuous range.
- Hold down Ctrl and click to select a discontinuous range.

To load the clip(s) in the Clip List Window, several methods are available:
Deleting Clips

When clips are loaded, the status message below the Clip List Window indicates the following:

- "<clip name> loaded" for a single clip.
- "X of Y clips loaded" for multiple clips (where X is the number of clips successfully attached out of Y total clips selected).

If an error occurs, the clip(s) will not be loaded, and the status message will indicate an error in the following format:

"<clip name> not loaded: <explanation of error>"

Additional controls are as follows:

- Click Load Live to load a clip with a duration of 24 hours instead of its listed duration. In this manner, a clip that is currently being recorded (a “live” clip) can be loaded with an indeterminate out point, allowing it to be played up to (and past) its current length.
- Click Close (or press the Esc key) to close the dialog box without performing further actions.

Deleting Clips

Use the following steps to delete clips:

**IMPORTANT:** Use caution when deleting clips. Once deleted, clips are permanently removed from the filesystem, and cannot be recovered.

1. Click the Load button in the Clip Management Area to display the Load Clips dialog box.
2. In the Load Clips dialog box, select the clip(s) that you want to delete. You can select a single clip or a range of clips.
3. Click the Delete button. When the Confirm dialog box appears, click Yes to delete the clip(s), or No (or Cancel) to cancel the procedure without deleting any clips.

**NOTE:** If the system is unable to delete a clip, there are two possible reasons. Either the clip’s “Protection Bit” has been set by an external application (such as an automation system), or the clip is on a playlist.

Renaming Clips

Use the following steps to rename clips:

1. Click the Load button in the Clip Management Area to display the Load Clips dialog box.
2. In the Load Clips dialog box, select the clip that you want to rename.
3. Click the Rename button. Click OK once you have renamed the clip, or Cancel to cancel the procedure without renaming the clip.
NOTE: You can also rename the currently active clip by selecting Rename clip from the Tools menu.

Copying Clips

Use the Copy Clip function to copy a frame accurate section of a clip and save it as a separate clip. The following figure shows the Copy Clip dialog box.

To copy a clip:
1. From the Tools menu, select Copy clip to display the Copy Clip dialog box.
2. Select the Handle Length check box if you would like to copy additional content before the in-point and after the out-point. Enter a value for the desired handle length. The copy will still play from in-point to out-point, but adding handles allows you to widen the clip duration at a later time.

NOTE: No beginning handle is added if the in-point is at the beginning of the clip and no ending handle is added if the out-point is at the end of the clip.

3. An available name is provided for the copy of the clip in the Copy Name field. You can either use this name or type a different name.
4. Click the Save button.

Recording Clips

Click the New button in the Clip Management Area (or click File > New Clip) to display the New Clip dialog box. The dialog box appears in one of two forms, depending on whether ClipTool Pro’s Time Mode is set to “Timecode” or “Frame Count” readouts. Choose these readouts from the Setup menu. See Setup Menu for a description of each readout.
Chapter 3 Using ClipTool Pro

Performing a Crash Record

A Crash Record allows you to record a clip without having to name the clip or set up its recording duration. This type of recording is beneficial when a quick recording is required.
Note the following important points:

- The Player must be set up for “Record Only” or “Play and Record” in the SystemManager.
- Starting a crash record ejects all clips on the current Player’s timeline.
- The crash record uses a default name (e.g., “Crash record 1”) to save you time. To change the default name, select Crash Record Options from the Tools menu. Each successive crash record uses the default name along with the next sequential number added to the end.

To perform a Crash Record:
1. Click REC to begin recording.
2. Click Stop to end the recording.

NOTE: To rename the clip once it’s been recorded, select Rename clip from the Tools menu.

Recording a Loop

The Loop Record function allows you to set up a continuous loop recording, comprised of several chunks, and then save a specific section of the loop as a single clip.

Note the following important points:

- Loop Record mode only works with DV and MPEG I-frame clips.
- The first chunk uses a default name (e.g., “Loop record0000”). As the Loop Record is performed, each successive chunk uses the default name along with the next sequential number added to the end.

The following figure shows the Loop Record dialog box.

To perform a Loop Record:
1. Select Loop Record from the Tools menu.
2. In the Loop Record Options dialog box, select the Loop Length and the Chunk Size. For example, a Loop Length of 1 hour with 10 minute chunks.
3. Click the Record button.
4. When Record is clicked, a clip name is created and added to your playlist. Recording then begins. When the Loop Record reaches the end of its Loop Length, the first chunk is replaced by the most recent chunk (once the recording has reached four times its loop length).

Saving the Loop Record

Creating a new clip requires ClipTool Pro to read and write various MediaDirector-resident essence files, a system and network intensive process that may take longer than real time. ClipTool Pro records four times the user-selected loop length; however, if the PC, MediaDirector or network resources are insufficient, a failure will occur.

Perform one or more of the following for optimal performance:
Use gigabit Ethernet connectivity between the PC and the MediaDirector.

- Reduce other activity on the MediaDirector host.
- Reduce other activity on the PC.
- Stop other ClipTool Pro operations while saving the new clip.

1. While the loop is recording, select **Save Loop** from the **File** menu.
2. In the **Save Loop** dialog box, you can use the **Mark/In** or **Mark/Out** buttons to specify the in-point and out-point of the segment of Loop to be saved.
   - The two **AGE** fields show the ages of the in-point and out-point frames (in other words, how long ago they were recorded). The maximum value in an **AGE** field is the length of the loop.
   - The two **TIME** fields show the internal timecodes of the in-point and out-point of the loop. The values in these **TIME** fields should correspond to the values of the **In** and **Out** Time fields in the editing area of the main window.
   - The **POS** field shows the current position of the Player.
3. In the **FILENAME** field, specify the filename.
4. Click the **Save** button to save the chunks as one clip. A dialog box shows progress of the save. Click the **Cancel** button if you are not ready to save the loop.
5. Click the **Stop** button in the **Transport Control** area to stop the Loop Record.

**Playout while Recording**

When using ClipTool Pro, the **Load Live** function allows you to load a clip with an open-ended duration of 24 hours instead of its listed duration. In this manner, a clip that is currently being recorded (a “live” clip) can be accessed by a “Playout” Player, loaded with an indeterminate out-point, and played back while the recording continues.

System problems can occur in this mode if the playback point (on the “Playout” Player) gets too close to the point of recording. In order to avoid problems, note the following important rules:

- If the “Playout” Player is on the same MediaDirector host as the “Record” Player, do not select a playback point that is within 10 seconds of the record point. Maintain a minimum 10-second safe zone between the playback and record points.
- If the “Playout” Player is on a different MediaDirector or host from the “Record” Player, do not select a playback point that is within 40 seconds of the record point. Maintain a minimum 40-second safe zone between the playback and record points.
These rules apply to ClipTool Pro, the Harmonic Player API, and any automation system that is controlling a Player.

Merging Clips

The **Merge Timeline** function allows you to create a single clip from several combined clips or subclips. You can also delete segments of clips before they are merged to further customize the final merged clip. Refer to *Editing Clips Prior to Merging* for instructions.

Merging a clip requires ClipTool Pro to read and write various MediaDirector-resident essence files, a system and network intensive process that may take longer than real time. Perform one or more of the following for optimal performance:

- Use gigabit Ethernet connectivity between the PC and the MediaDirector.
- Reduce other activity on the MediaDirector host.
- Reduce other activity on the PC.
- Stop other ClipTool Pro operations while saving the new clip.

**IMPORTANT:** Only intra-frame compressed material such as MPEG iFrame or DV files can be merged. LongGOP or IMX material cannot be merged.

To merge clip timelines:

1. Click the **Load** button in the **Clip Management Area** to display the **Load Clips** dialog box.
2. In the **Load Clips** dialog box, select the clips that you want to merge.
3. Close the dialog box when you have finished selecting clips.
4. Select **Merge Timeline** from the **Tools** menu.

5. Type a new name to save the merged clips as a separate file, otherwise the current clip name shown is used and that clip is replaced by the newly merged clip.

**NOTE:** All clips on the timeline are ejected if you choose a name for the merged file that matches the name of a clip on the timeline.

6. Click the **Save** button to merge the clips. The new file is placed in the current clip directory. The merge will not occur if the timeline contains clips with incompatible formats, differences in bitrates or other incompatibilities.
**Editing Clips Prior to Merging**

In addition to combining entire clips, you can delete segments of clips before they are merged. For example, you may only want to keep the beginning and end of a clip. The example below describes editing the same clip before it is merged.

1. Click the **Load** button in the Clip Management Area and then load the same clip **twice**.
2. Adjust the first clip’s out-point so that it is **before** the segment you want removed.
3. Adjust the second clip’s in-point so that it is **after** the segment you want to removed.
4. Combine the clips as described in **Merging Clips**. When the clips are merged, the middle section of the clip is deleted and the new clip now consists of the beginning and the end of the original clip.

**Clip Dubbing**

Choose from the following topics:

- **Introduction to Clip Dubbing**
- **Clip Dubbing Operations**
- **Clip Dubbing Restrictions**

**Introduction to Clip Dubbing**

Clip dubbing is a special ClipTool Pro function (configured in the SystemManager) by which you connect a **Source Player** to one or more **Target Players**, and trigger all Players in sync in order to copy the material that is present on the source Player’s timeline. The Target “recording” Players may be located on the same MediaDirector as the Source Player, or on other MediaDirectors.

Two types of connections can be made between the Source Player and the Target Player:

- A direct IEEE 1394 connection may be used, in which case the dubbed material is a direct copy of the source. For example, if a DV25 clip is the source, a DV25 clip is recorded. This type of connection cannot be used between Players on a single MediaDirector, but it can be used between multiple MediaDirectors. Note that Long GOP MPEG can be dubbed with direct IEEE 1394 connections, if you dub **one clip at a time**.

- MediaPorts can be used, with a physical (BNC) connection from the output of the source MediaPort to the input of the target MediaPort. This configuration allows a format conversion during the dubbing process. For example, if a DV25 clip is the source, an MPEG clip can be recorded on the target. This type of connection can be used on a single MediaDirector or between multiple MediaDirectors.

During the dubbing process, ClipTool Pro controls a single “gang” comprised of a Source Player (the Player normally controlled by ClipTool Pro) and one or more Target Players that are slaved to the source. The “gang” is invisible to normal ClipTool Pro operations, and consumes no processing time unless dubbing is in progress. When a dub is made, only the Source Player’s status is reflected in the ClipTool Pro’s user interface.

A gang may be specified before ClipTool Pro is started. This function is performed in the SystemManager application, in the **Edit Player** screen’s **Clip Dubbing Section**. Refer to “Edit Player Screen” in the **Harmonic SystemManager User’s Guide** for orientation information and an explanation of the **Player-to-Player Dubbing Section**.

The “preset” gang may have an arbitrary number of Target Players in it, and this gang will be used whenever dubbing is invoked. If no gang was specified prior to startup, ClipTool Pro asks you for a single Recorder to connect for dubbing, when the dub function is requested.
Note the following important points:

- ClipTool Pro’s dubbing function simply records the current contents of the Source Player’s timeline onto the ganged Target Players.

- The source timeline may include one clip or a sequence of clips (for DV and non-Long GOP MPEG clips). For Long GOP MPEG clips, only one clip may be dubbed at a time.

- You can dub to identically named clip(s) on the Target Player(s), or the entire timeline may be dubbed to a single new clip on the Target(s). If there are multiple clips on the Source timeline in the latter case, the dub can be thought of as compiling a new clip from edited segments of existing clips. In this way, ClipTool Pro serves as a simple, cuts-only editor.

When dubbing is invoked, a series of important tests are performed:

- Are all Recorders connected, communicating, and enabled for recording?
  Dubbing cannot proceed if any communication or connection function fails, or cannot be performed.

- Do all gang members reside on the same MediaDirector, or share the same timecode reference?
  If all gang members are on the same MediaDirector, they can all be triggered on the same reference frame count. If all share the same reference timecode, they can all be triggered frame-accurately. If neither condition is met, frame-accurate recording cannot be guaranteed. ClipTool Pro will refuse to dub unless the gang has a common reference, or all members reside on the same MediaDirector.

- Are all gang members running at the same frame rate?
  All ganged Players must be running at the same frame rate for correct dubbing.

- Are there any duplicate clip names in the timeline?
  If clips are to be dubbed to clips of the same name on the destinations, only one clip (or clip segment) of a given name may be present on the target timeline, otherwise the first dub to that name will be overwritten by the following dub of that name.

  Multiple copies of a clip may still reside on the source timeline, as long as you dub that timeline to a single target clip with a new name. For example, if you have an hour-long sports clip that contains many highlights, you can place multiple instances of it (each with the same name) on the source timeline. You can then trim heads and tails on each clip to isolate desired highlights. The resulting “edited” version can be dubbed to a Target Player, but the target clip must have a different name than the source clips.

- Do any destination names conflict with the names of existing clips?
  ClipTool Pro will not allow you to overwrite existing clips. If clips are found on the target players’ filesystems that have the same names as source clips, a warning is issued. This rule applies both to the names of the source clips and to names you specify. ClipTool Pro only allows you to dub clips with non-conflicting names.

  For example, if you want to convert a DV clip named “Harmonic” to an SDI clip named “Harmonic,” the system will not permit it if the source and target files are in the same filesystem. In this case, rename the target clip to perform the dub.

- Do the Target Players have enough space available to record the timeline?
ClipTool Pro compares the length of the source timeline with the “free time” reports from each of the Target Players. If any of the targets fall short of the required time, you will see a warning. Dubbing, however, may still proceed because the “free time” estimate is a dynamic number that changes depending on the actions of many filesystem processes. You can also cancel the dub and make adjustments accordingly.

Once all the tests have been passed, dubs proceed in real time. ClipTool Pro shows the source Player in play mode. All controls other than Stop are disabled, and the Transport Status readout displays a red label that alternates between “DUBBING” and the current transport mode.

Dubbing proceeds until the source timeline has completed. Dubbing is halted if ClipTool Pro loses contact with any Source or Target Player, if any error is reported, if the Source Player stops playing, if any Target Player stops recording, or if any targets report “no free space” left. Click Stop at any time to halt the dub prematurely. Upon conclusion of the dub, all Target Players are stopped and their timelines are ejected. A window displays a summary of the actions taken.

**Clip Dubbing Operations**

Use the following steps to dub clips:

1. Determine if you want to dub via IEEE 1394, or via physical I/O devices (e.g., MediaPort to MediaPort). Please note:
   - If you elect to dub via IEEE 1394, the SystemManager will handle all connections, but format conversion is not allowed. An IEEE 1394 connection is required to dub between MediaDirectors.
   - If you elect to dub via physical I/O devices, all physical (BNC) connections are your responsibility — the SystemManager does not handle them. Format conversion is allowed in this configuration. As required, connect cables between the Source MediaPort’s output and the Target MediaPort’s input.
   - If you elect to use multiple targets, they must be on different active filesystems.

2. Pre-select Target Player(s) using the SystemManager:
   a. Select the desired MediaDirector host, and navigate to the Player List.
   b. Select (or create) the Target Player that you want to use. If the Target Player already exists, click the Edit Hyperlink to display the Edit Player screen. If the Player is new, the Edit Player screen will be automatically accessed when you enter the new Player name.
   c. Assign the desired audio and video formats to the Target Player.
   d. If you are performing dubbing via physical I/O devices, connect the tracks on the Target Player to the appropriate devices. Refer to “Creating a .Player File” in the Harmonic SystemManager User’s Guide for player creation and editing instructions.
   e. If you are performing IEEE 1394 clip dubbing, ensure that the Player is disconnected from any MediaPorts.
   f. For both types of clip dubbing, ensure that the Player is inactive.
   g. Repeat this step to create additional targets — on the same MediaDirector (only if you elect to dub via physical I/O devices), or on a different MediaDirector for both types of clip dubbing.

3. Pre-select a Source Player using the SystemManager:
   a. Select the desired MediaDirector host, and navigate to the Player List.
   b. Select (or create) the Source Player that you want to use.
   c. If the Source Player already exists, click the Edit Hyperlink to display the Edit Player screen. If the Player is new, the Edit Player screen will be automatically accessed when you enter the new Player name.
d. Assign the desired audio and video formats to the Source Player.

e. If you are performing dubbing via physical I/O devices, connect the tracks on the Source Player to the appropriate devices. Refer to “Creating a Player File” in the Harmonic SystemManager User’s Guide for player creation and editing instructions.

f. If you are performing IEEE 1394 clip dubbing, ensure that the Player is disconnected from any MediaPorts.

4. From the Source Player’s Edit Player screen, you can now configure the Source-to-Target connection:

a. At the bottom of the Edit Player screen, in the Target Player drop-down box, choose the target Player. The SystemManager lists all valid Players (of which it has knowledge) on all MediaDirectors within the Harmonic system.

b. Click Connect via 1394 or Connect via I/O Device (depending upon the method by which you choose to dub). Repeat this step to connect additional targets. The Player List will reflect your source and target choices.

NOTE: When the Source-to-Target connection is successful, the name of the Target Player’s MediaDirector appears in each track’s list of attached devices.

On the Player List, note that the label “(Source:#)” appears after the Source Player’s status indicator, and label “(Target)” appears after the Target Player’s status indicator. The # indicates the number of Target Players connected.

5. With all connections complete, activate the Source Player. This action automatically activates all Target Players.

Refer to “Activating and Deactivating Players” in the Harmonic SystemManager User’s Guide for instructions.

6. On the Player List, click the Open Hyperlink to open ClipTool Pro for the selected Source Player.

7. Place one or more clips on the source timeline and trim the clips as required.

IMPORTANT: Long GOP IEEE 1394 clip dubbing can be performed, if it is done one clip at a time.

8. On ClipTool Pro’s Menu Bar, click File > Dubbing. Please note:

   - If you preconfigured your Source and Target “gang” and launched ClipTool Pro from the SystemManager, the Choose Recording MediaDirector/Player dialog box does not appear. Please continue with step 9.
   - If the gang was not predefined or if you launched ClipTool Pro from the desktop, the Choose Recording MediaDirector/Player dialog box appears, asking you to select a Target Player.
   - A sample Choose Recording MediaDirector/Player dialog box is shown in the figure below.
This dialog box allows you to define a gang on the fly for ad-hoc dubbing. Select the desired Target Player (only one may be selected) and click OK.

9. The Dub Timeline Selection dialog box appears, asking that you choose what action to take on the Target Player(s).

10. Select ...clip(s) of the same name(s) to record all source clips to clips of the same name on the Target Player(s). In this mode, source clips will be dubbed to the Target(s) one-for-one. This selection can only be used with Targets residing on another filesystem.
   - Additionally, the marked in-points and out-points will be preserved in the dubs. For example, if a source clip has been trimmed to frames 100-200, then the dubs will all start at frame 100 and end at frame 200.

11. Select ...a single new clip to record the entire source timeline to a single target clip with a name you specify. Fill in the name of the desired target clip.
   - In this mode, the entire timeline is recorded to a new clip starting at frame 0. Even if you dub a single clip and specify its existing name as the “new” name, it will start at zero.

12. With your selection made, click OK. ClipTool Pro now checks the pending dub operation. If no problems are found, the dub begins. If, however, potential problems are found, the Dub Preprocessing dialog box appears, a sample of which is shown in the following figure.

The scrolling window dialog box shows a comprehensive list of status checks, including sync status, the names of the gang members and any possible problems detected. The line of text below the list reports the most pressing problem.

13. Click Cancel (or press Enter or Esc) to cancel the dub. Cancel is the default selection.

14. Click OK to proceed with dubbing. ClipTool Pro will also process any conflicts by ejecting source clips with conflicting names. It will then load the target timelines with appropriately named and sized clips in which to record.

When dubbing commences, the Source Player cues at the head of the timeline and the Target Players cue into record. All transport controls other than Stop are disabled, and the Transport Status readout flashes between the current state and “DUBBING.”
Chapter 3 Using ClipTool Pro

Clip Dubbing

Note the following points regarding the dub in progress:

- Use the List button to hide and show the clip list, but remember that all other controls (other than Stop) are unavailable.
- Press Stop to halt the dub. In this case, dubbing stops and the clip currently being recorded on the Target(s) will be incomplete.
- ClipTool Pro monitors the dubbing process and halts on any of the following conditions:
  - The Source or Target Player fails to respond or reports an error.
  - A Target Player runs out of space.
  - The Source Player reports a status other than “Cued for Play” or “Play”.
  - A Target Player reports a status other than “Cued for Record” or “Record”.
  - The end of the playback timeline is reached (normal completion).
  - Stop is pressed.

When dubbing ends, the Dub Information dialog box appears with a summary of the operations performed and the reason that the dubbing ended.

15. Repeat the procedure from Step 7 to dub additional clips.

Clip Dubbing Restrictions

When using the “Clip Dubbing” feature or when performing dubbing using the Harmonic API, please note:

- All Players concerned should have MediaPorts attached (and the MediaPorts should be connected to each other for the dub), or
- None of the Players should have MediaPorts attached (and IEEE 1394 dubbing should be performed).
Internally, Harmonic Players detect the presence or absence of MediaPorts, and adjust their timing appropriately, as MediaPorts add a certain amount of delay to the video. When no MediaPorts are connected and direct IEEE 1394 dubbing occurs, the source Player and recording Player start at the same time, and a frame-accurate dub occurs. When a MediaPort-to-MediaPort dub is performed, the source Player and the recording Players retime their playout and recording start times so that frame-accurate dubbing still occurs — despite the delay added by the MediaPorts.

It is possible to “break” dubbing by setting up an IEEE 1394 dub between Players, one or more of which has a MediaPort attached. In such cases, the Players adjust their timing to take into account the MediaPort-induced delays, but as the actual connection is via a direct IEEE 1394 link, the recording will be off by several frames.

For example, for monitoring purposes, one might be tempted to attach a MediaPort to a direct IEEE 1394 dubbing Player or recorder. Unfortunately, doing so will break dubbing. Therefore, the following rules need to be observed:

- For direct IEEE 1394 dubs, none of the Players may have a MediaPort attached.
- For dubbing to/from a Player with a MediaPort, connect it using a baseband SDI connection between MediaPorts — not a direct IEEE 1394 link.

## Saving and Opening Playlists

ClipTool Pro allows you to save a playlist of all the clips in the Clip List Window. The playlist retains all the Mark In and Mark Out points of each clips. To save a playlist, click File and then select Save Playlist. The playlist will be saved as an XML file.

To open an existing playlist, click File and then select Open Playlist. Browse to the XML file that contains the playlist you want and select to open it.

Opening a playlist will cause ClipTool Pro to stop the player, eject any content that was already loaded, load the new clips, and then reset the time fields to the beginning of the first clip in the playlist.

## Changing Default Settings for New Clips and the Clip List

The initialization file, ClipToolPro.ini, located in the ClipTool Pro application folder allows you to modify certain default settings. By modifying this .ini file you can:

- Specify the default recording duration for a new clip
- Specify whether or not ClipTool Pro, upon start-up, automatically displays all the currently loaded clips for the player with which it’s associated in the Clip List window.

To modify the default settings:

1. Locate the file, ClipToolPro.ini, in the same folder which contains the ClipTool Pro application. (The default location is C:\Program Files\Harmonic\ClipTool Pro).
2. Open ClipToolPro.ini with a text editing program such as NotePad.
3. Type in the following parameters below the line, FrontKey=1:
   
   ```plaintext
   Duration=<default recording duration specified in frames>  
   ClipList=<1 displays loaded clips, 0 does not display loaded clips>
   ```

   The following is an example of a modified ClipToolPro.ini file:
   
   ```plaintext
   [User Options]
   ```
4. Save and close ClipToolPro.ini.
5. Restart ClipTool Pro in order for your changes to take effect.

**ClipTool Pro Keyboard Shortcuts**

The following keyboard shortcuts are available with ClipTool Pro.

<table>
<thead>
<tr>
<th>Table 3–1: Keyboard Shortcuts</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>ClipTool Pro Shortcuts</strong></td>
</tr>
<tr>
<td>Alt+F4</td>
</tr>
<tr>
<td>F10, Alt (by itself)</td>
</tr>
<tr>
<td>Alt+&lt;underlined character&gt;</td>
</tr>
<tr>
<td>ENTER</td>
</tr>
<tr>
<td>Tab</td>
</tr>
<tr>
<td>Shift+Tab</td>
</tr>
<tr>
<td>Esc</td>
</tr>
<tr>
<td>Ctrl+X</td>
</tr>
<tr>
<td>Ctrl+C</td>
</tr>
<tr>
<td>Ctrl+V</td>
</tr>
</tbody>
</table>

JKL keys are a common NLE shortcut for motion control:

- Pressing J or L alone works like pressing the left and right shuttle buttons, except that speeds below 1x are not selected. The speeds obtainable are thus -32, -16, -8, -4, -2, -1, 1, 2, 4, 8, 16, and 32, listed as multiples of normal forward play speed.

- Pressing J changes the current speed to the next leftward speed (towards faster reverse speeds), while pressing L changes the current speed to the next rightward speed (towards faster forward speeds).

- When stopped or paused, or in slow play, pressing L starts forward playback at normal speed, while pressing J starts reverse playback at normal speed.

- J and L do not auto-repeat. To speed up or slow down (move to the next speed setting), you must release the key, and then press it again.

- Pressing K pauses the video.

- Pressing J and K in combination, or K and L in combination, causes slow (quarter-speed) playback in reverse or forward respectively. Releasing J or L while K is depressed pauses playback. Releasing K while J or L is depressed starts reverse or forward play at normal speed until K is pressed again or the J or L key is released, at which point playback pauses.
Appendix A  
Contacting the Technical Assistance Center

Harmonic Global Service and Support has many Technical Assistance Centers (TAC) located globally, but virtually co-located where our customers can obtain technical assistance or request on-site visits from the Regional Field Service Management team. The TAC operates a Follow-The-Sun support model to provide Global Technical Support anytime, anywhere, through a single case management and virtual telephone system. Depending on time of day, anywhere in the world, we will receive and address your calls or emails in one of our global support centers. The Follow-the-Sun model greatly benefits our customers by providing continuous problem resolution and escalation of issues around the clock.

Table A–1: For Distribution and Delivery (Legacy Harmonic) Products

<table>
<thead>
<tr>
<th>Region</th>
<th>Telephone Technical Support</th>
<th>E-mail</th>
</tr>
</thead>
<tbody>
<tr>
<td>Americas</td>
<td>888.673.4896 or 408.490.6477</td>
<td><a href="mailto:support@harmonicinc.com">support@harmonicinc.com</a></td>
</tr>
<tr>
<td>EME</td>
<td>+44.1252.555.450</td>
<td><a href="mailto:support.emea@harmonicinc.com">support.emea@harmonicinc.com</a></td>
</tr>
<tr>
<td>Asia Pacific – Other Territories</td>
<td>+852.3713.9300</td>
<td><a href="mailto:hongkongtechsupport@harmonicinc.com">hongkongtechsupport@harmonicinc.com</a></td>
</tr>
<tr>
<td>India</td>
<td>+44.1252.555.450</td>
<td><a href="mailto:support.emea@harmonicinc.com">support.emea@harmonicinc.com</a></td>
</tr>
<tr>
<td>Russia</td>
<td>+7.495.926.4608</td>
<td><a href="mailto:rusupport@harmonicinc.com">rusupport@harmonicinc.com</a></td>
</tr>
<tr>
<td>Africa</td>
<td>+44.1252.555.450</td>
<td><a href="mailto:support.emea@harmonicinc.com">support.emea@harmonicinc.com</a></td>
</tr>
<tr>
<td>Mainland China</td>
<td>+86.10.8391.3313</td>
<td><a href="mailto:chinatechsupport@harmonicinc.com">chinatechsupport@harmonicinc.com</a></td>
</tr>
</tbody>
</table>

Table A–2: For Production and Playout (Legacy Omneon and Rhozet) Products

<table>
<thead>
<tr>
<th>Region</th>
<th>Telephone Technical Support</th>
<th>E-mail</th>
</tr>
</thead>
<tbody>
<tr>
<td>Americas</td>
<td>888.673.4896 or 408.490.6477</td>
<td><a href="mailto:omneon.support@harmonicinc.com">omneon.support@harmonicinc.com</a></td>
</tr>
<tr>
<td>EMEA</td>
<td>+44.1252.555.450</td>
<td><a href="mailto:omneonemeasupport@harmonicinc.com">omneonemeasupport@harmonicinc.com</a></td>
</tr>
<tr>
<td>Asia Pacific – Other Territories</td>
<td>+65.6542.0050</td>
<td><a href="mailto:apacsupport@harmonicinc.com">apacsupport@harmonicinc.com</a></td>
</tr>
<tr>
<td>Japan</td>
<td>+81.3.5565.6737</td>
<td><a href="mailto:japansupport@harmonicinc.com">japansupport@harmonicinc.com</a></td>
</tr>
<tr>
<td>China - Mainland</td>
<td>+86.10.8391.3313</td>
<td><a href="mailto:chinasupport@harmonicinc.com">chinasupport@harmonicinc.com</a></td>
</tr>
<tr>
<td>Russia and CIS</td>
<td>+7.495.926.4608</td>
<td><a href="mailto:rusupport@harmonicinc.com">rusupport@harmonicinc.com</a></td>
</tr>
</tbody>
</table>
The Harmonic Inc. support website is:
http://www.harmonicinc.com/content/technical-support

The Harmonic Inc. Distribution and Delivery product software downloads site is:
ftp://ftp.harmonicinc.com

The Harmonic Inc. Playout and Production software downloads site is:

The Harmonic Inc. corporate address is:
Harmonic Inc.
4300 North First St.
San Jose, CA 95134, U.S.A.
Attn: Customer Support

The corporate telephone numbers for Harmonic Inc. are:
Tel. 1.800.788.1330 (from the U.S. and Canada)
Tel. +1.408.542.2500 (outside the U.S. and Canada)
Fax.+1.408.542.2511
Appendix B
Compliance, Safety, and Agency Approvals

NOTE: The information in this appendix may apply to purchased products.

This equipment generates, uses, and can radiate radio frequency energy. It may cause harmful interference to radio communications if it is not installed and used in accordance with the instructions in this manual. Operation of this equipment in a residential area is likely to cause harmful interference. If this occurs, the user will be required to correct the interference at his or her own expense.

This equipment has been tested and found to comply with the limits for a Class A digital device, pursuant to Part 15, Subpart B of the Federal Communications Commission (FCC) rules.

These limits are designed to provide reasonable protection against harmful interference when the equipment is operated in a commercial environment.

This device complies with Part 15 of the FCC rules. Operation is subject to the following two conditions: (1) this device may not cause harmful interference, and (2) this device must accept any interference received, including interference that may cause undesired operation.

Connections between the Harmonic equipment and other equipment must be made in a manner that is consistent with maintaining compliance with FCC radio frequency emission limits. Modifications to this equipment not expressly approved by Harmonic may void the authority granted to the user by the FCC to operate this equipment.

WEEE/RoHS Compliance Policy

Harmonic Inc. intends to comply fully with the European Union’s Directive 2002/96/EC as amended, on Waste Electrical and Electronic Equipment, also known as “WEEE,” and Directive 2002/95/EC, as amended, on the Restriction of use of Hazardous Substances, also known as “RoHS.”

Harmonic will ensure that product which cannot be reused will be recycled in compliance with the WEEE Directive. To that end, users are advised that (1) Harmonic equipment is not to be discarded in household or office garbage, (2) Harmonic Inc. will pay the freight for shipment of equipment to be disposed of if it is returned to Harmonic, (3) customers should call the normal RMA telephone numbers to arrange for such shipment, and (4) for additional and updated information on this process customers may consult the Harmonic website: http://harmonicinc.com/pa_weee_recycle.cfm.

Harmonic will ensure that its products will be either reused or recycled in compliance with the WEEE Directive. For the latest information concerning Harmonic’s WEEE/RoHS Compliance Policy and its Recycling and Take-Back process, please visit our web site.
Restricted Substance Statement

Harmonic products contain less than the permitted limits for the six restricted substances except where exemptions published in the RoHS Directive are applicable. This statement is based on vendor-supplied analysis or material certifications, and/or lab test results of the component raw materials used in the manufacture of Harmonic products.

<table>
<thead>
<tr>
<th>Restricted Substance</th>
<th>Permitted limit*</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cadmium (Cd)</td>
<td>≤ 0.01% (Cd)</td>
</tr>
<tr>
<td>Lead (Pb)</td>
<td>≤ 0.1% (Pb)</td>
</tr>
<tr>
<td>Chromium (VI) (Cr (VI))</td>
<td>≤ 0.1% (Cr VI)</td>
</tr>
<tr>
<td>Mercury (Hg)</td>
<td>≤ 0.1% (Hg)</td>
</tr>
<tr>
<td>Polybrominated Biphenyls</td>
<td>≤ 0.1% (PBBs)</td>
</tr>
</tbody>
</table>

*Homogeneous material definition as per the EU Directive.

Names and Contents of Toxic and Hazardous Substances

This section lists the names of contents of toxic or hazardous substances, or elements in the products if the part is present.

This table shows those components where hazardous substances may be found in Harmonic products based on, among other things, material content information provided by third party suppliers. These components may or may not be part of the product.

除非特殊注明，哈雷公司产品的环保使用期限 均为 20 年。该环保使用期限的有效条件为：必须遵循该产品使用手册的规定，对该产品进行使用或存储。

The Environmental Protective Use Period for Harmonic products is 20 years unless displayed otherwise on the product. The EPUt period is valid only when the products are operated or stored as per the conditions specified in the product manual.

<table>
<thead>
<tr>
<th>部件名称 (Part name)</th>
<th>有毒有害物质或元素 (Hazardous Substance)</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>铅 (Pb)</td>
</tr>
<tr>
<td>印刷线路板 (Printed Circuit Assemblies)</td>
<td>X</td>
</tr>
<tr>
<td>机械组件 (Mechanical Subassemblies)</td>
<td>X</td>
</tr>
<tr>
<td>光学组件 (Optical Subassemblies)</td>
<td>X</td>
</tr>
</tbody>
</table>
### Names and Contents of Toxic and Hazardous Substances

<table>
<thead>
<tr>
<th>部件名称 (Part name)</th>
<th>有毒有害物质或元素 (Hazardous Substance)</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>铅 (PB)</td>
</tr>
<tr>
<td>电源 (Power Supplies)</td>
<td>X</td>
</tr>
<tr>
<td>缆线 / 线束 (Cables, harnesses)</td>
<td>X</td>
</tr>
<tr>
<td>屏幕 / 显示器 (Screens, Monitors)</td>
<td>X</td>
</tr>
<tr>
<td>金属零件 (Metal Parts)</td>
<td>O</td>
</tr>
<tr>
<td>塑料 / 发泡材料 (Plastics, foams)</td>
<td>O</td>
</tr>
<tr>
<td>电池 (Batteries)</td>
<td>O</td>
</tr>
</tbody>
</table>

O: 表示在该部件的所有均质材料中，此类有毒有害物质的含量均小于 SJ/T11363-2006 标准所规定的限量。

O: Indicates the content of the toxic and hazardous substances at the homogeneous material level of the parts is below the limit defined in SJ/T11363 2006 standard.

X: 表示至少在该部件的某一均质材料中，此类有毒有害物质的含量超出 SJ/T11363-2006 标准规定的限量。

X: Indicates that the content of the toxic and hazardous substances in at least one of the homogeneous materials of the parts is above the limit defined in SJ/T11363 2006 standard.

<table>
<thead>
<tr>
<th>기종별</th>
<th>사용자 안내문</th>
</tr>
</thead>
<tbody>
<tr>
<td>A급 기기 (업무용 정보통신기기)</td>
<td>이기기는 업무용으로 전자파적합등록을 한 기기이기나 판매자 또는 사용자는 이 점을 주의하시기 바라며 만약 잘못 판매 구입하였을 때에는 가정용으로 교환하시기 바랍니다.</td>
</tr>
</tbody>
</table>
Standards and Agency Approval

The following tables list regulatory standards and agency approvals:

North America

<table>
<thead>
<tr>
<th>Standards</th>
<th>Agency Approval</th>
</tr>
</thead>
<tbody>
<tr>
<td>EMI: FCC Part 15, Subpart B, ICES-003, Issue 2, Class A</td>
<td>FCC</td>
</tr>
<tr>
<td>Safety: UL60950-1, CAN/CSA C22.2 No. 60950-1</td>
<td>cULV-us Mark</td>
</tr>
</tbody>
</table>

Europe

<table>
<thead>
<tr>
<th>Standards</th>
<th>Agency Approval</th>
</tr>
</thead>
<tbody>
<tr>
<td>EMI/EMC: EN55022 Class A, EN55024, EN61000-3-2 and EN61000-3-3</td>
<td>CE</td>
</tr>
<tr>
<td>Safety: EN 60950-1, EN60825-1</td>
<td>TUV-GS or T-Mark, CE</td>
</tr>
<tr>
<td>RoHS2: Directive 2011/65/EU</td>
<td>CE</td>
</tr>
</tbody>
</table>

Japan

<table>
<thead>
<tr>
<th>Standards</th>
<th>Agency Approval</th>
</tr>
</thead>
</table>

Australia and New Zealand

<table>
<thead>
<tr>
<th>Standards</th>
<th>Agency Approval</th>
</tr>
</thead>
<tbody>
<tr>
<td>EMI: AS/NZS CISPR22</td>
<td>AS/NZS CISPR22</td>
</tr>
</tbody>
</table>

Canadian EMC Notice of Compliance

English: This digital apparatus does not exceed the Class A limits for the radio noise emissions from digital apparatus set out in the Radio Interference Regulations of the Canadian Department of Commerce.

French: Le présent appareil numérique n’émet pas de bruits radioélectriques dépassant les limites applicables aux appareils numériques de la classe A prescrites dans le Règlement sur le brouillage radioélectrique édicté par le ministère des Communications du Canada.

EU Manufacturer’s Declaration of Conformity

We: Harmonic, Inc.

Declare under our sole responsibility that the products identified below comply with the following EU Directives and Harmonized Standards stated.
## Applicable EU Directives for ContentBridge:

<table>
<thead>
<tr>
<th>Regulatory Compliance</th>
<th>Directive(s)</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>ContentBridge 1000</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>EMC</td>
<td>FCC Part 15, ICES-003, CISPR 22, 2004/108/EC Electromagnetic Compatibility</td>
<td>Class A for Digital Equipment, USA, Canada EN55022, EN61000-3-2,</td>
</tr>
<tr>
<td></td>
<td></td>
<td>EN61000-3-3, and EN55024</td>
</tr>
<tr>
<td>Safety</td>
<td>TUV 2006/95/EC Low Voltage Directive including amendments</td>
<td>UL60950-1, CAN/CSA-C22.2 No. 60950-1 Safety of Information Technology</td>
</tr>
<tr>
<td><strong>ContentBridge 2010A</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>EMC</td>
<td>FCC, ICES, CE Mark, VCCI, BSMI, C-Tick, SABS, CCC, MIC</td>
<td>Class A</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Class B En 55022 Class B, En55024, En61000-3-2, En61000-3-3</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Class B Class A Class B Class A Class B Class A</td>
</tr>
<tr>
<td>Safety</td>
<td>UL, CAN/CSA, EN, IEC</td>
<td>UL 60950-1 CAN/CSA-C22.2 No. 60950-1 EN 60950-1, EN60825-1, EN60825-2</td>
</tr>
<tr>
<td></td>
<td></td>
<td>IEC60950-1</td>
</tr>
<tr>
<td>Regulatory Compliance</td>
<td>Directive(s)</td>
<td>Notes</td>
</tr>
<tr>
<td>-----------------------</td>
<td>-----------------------------------------------------------------------------</td>
<td>----------------</td>
</tr>
<tr>
<td>EMC</td>
<td>ACMA or C-Tick&lt;br&gt;BELLIS&lt;br&gt;KVALITET&lt;br&gt;ICES&lt;br&gt;CNCA or CCC&lt;br&gt;KONCAR&lt;br&gt;CE&lt;br&gt;SII&lt;br&gt;VCCI&lt;br&gt;OTAN – CKT&lt;br&gt;INSM&lt;br&gt;NEMKO&lt;br&gt;GOST&lt;br&gt;SABS&lt;br&gt;KCC&lt;br&gt;BSMI&lt;br&gt;UKRTEST or&lt;br&gt;UKRSERTCOMPUTER&lt;br&gt;FCC&lt;br&gt;STZ&lt;br&gt;ICT</td>
<td>Class A</td>
</tr>
<tr>
<td>Safety</td>
<td>IRAM&lt;br&gt;BELLIS&lt;br&gt;SCC&lt;br&gt;CNCA or CCC&lt;br&gt;KONCAR&lt;br&gt;CE&lt;br&gt;TUV&lt;br&gt;IECEE&lt;br&gt;IECEE CB&lt;br&gt;SII&lt;br&gt;OTAN – CKT&lt;br&gt;KEBS&lt;br&gt;KUCAS&lt;br&gt;NYCE or NOM&lt;br&gt;INSM&lt;br&gt;SONCAP&lt;br&gt;NEMKO&lt;br&gt;GOST&lt;br&gt;KSA ICCP&lt;br&gt;NRCS&lt;br&gt;BSMI&lt;br&gt;UKRTEST or&lt;br&gt;UKRSERTCOMPUTER&lt;br&gt;NRTL&lt;br&gt;STZ</td>
<td></td>
</tr>
</tbody>
</table>
Applicable EU Directives for ContentDirector:

<table>
<thead>
<tr>
<th>Regulatory Compliance</th>
<th>Directive(s)</th>
<th>Notes</th>
</tr>
</thead>
</table>
| **EMC**               | ACMA or C-Tick  
BELLIS  
KVALITET  
ICES  
CNCA or CCC  
KONCAR  
CE  
SII  
VCCI  
OTAN – CKT  
INSM  
NEMKO  
GOST  
SABS  
KCC  
BSMI  
UKRTEST or UKRSERTCOMPUTER  
FCC  
STZ  
ICT | Class A |
| **Safety**            | IRAM  
BELLIS  
SCC  
CNCA or CCC  
KONCAR  
CE  
TUJV  
IECEE  
IECEE CB  
SII  
OTAN – CKT  
KEBS  
KUCAS  
NYCE or NOM  
INSM  
SONCAP  
NEMKO  
GOST  
KSA ICCP  
NRCS  
BSMI  
UKRTEST or UKRSERTCOMPUTER  
NRTL  
STZ |
Applicable EU Directives for ContentServer and ContentStore:

<table>
<thead>
<tr>
<th>Regulatory Compliance</th>
<th>Directive(s)</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>ContentServer 1042B/1042C-DP</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>ContentServer 2122/2124</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>EMC</td>
<td>FCC Part 15, ICES-003 CISPR 22 89/336/EEC Electromagnetic Compatibility including amendments</td>
<td>Class A for Digital Equipment, USA, Canada EN55022 EMISSIONS EN61000-3-2, EN61000-3-3 EN55024 Immunity</td>
</tr>
<tr>
<td><strong>ContentServer 3000</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>EMC</td>
<td>FCC (CFR 47, Part 15) Class A IECS-003, Issue 3, Class A</td>
<td>EN 55022, EN1000-2-3, EN1000-3-3 EN55024, AS/NZS 3548 (CISPR-22 Class A) VCCI V-3</td>
</tr>
<tr>
<td>Safety</td>
<td>IEC/EN 60950-1: CB report and CB certificate UL/CSA 60950-1: cTUVus-mark</td>
<td></td>
</tr>
<tr>
<td><strong>ContentStore 3160</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Regulatory Compliance</td>
<td>Directive(s)</td>
<td>Notes</td>
</tr>
<tr>
<td>-----------------------</td>
<td>-------------</td>
<td>-------</td>
</tr>
</tbody>
</table>
| EMC                   | FCC (CFR 47, Part 15) Class A  
IESCS-003, Issue 3, Class A | EN 55022, EN1000-2-3,  
EN1000-3-3  
EN55024, AS/NZS 3548  
(CISPR-22 Class A)  
VCCI V-3 |
| Safety                | IEC/EN 60950-1: CB report and CB certificate  
UL/CSA 60950-1: cTUVus-mark |

© 2013 Harmonic Inc. All rights reserved. 47 ClipTool Pro Release 3.2
## Applicable EU Directives for Network Switch 2924, 2948 and 5406:

<table>
<thead>
<tr>
<th>Regulatory Compliance</th>
<th>Directive(s)</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>CE</td>
<td>Low Voltage Directive is: 2006/95/EC, EMC directive is: 2004/108/EC</td>
<td>EN60950-1 Safety of Information Technology Equipment</td>
</tr>
<tr>
<td>EMC</td>
<td>FCC, VCCI, EN, CISPR-22</td>
<td>Class A, Class A, CISPR 22</td>
</tr>
<tr>
<td>Safety</td>
<td>CSA 22.2, UL, IEC, EN</td>
<td>No. 60950-1, 60950-1, 60950-1</td>
</tr>
</tbody>
</table>

## Applicable EU Directives for the MediaDeck 7000:

<table>
<thead>
<tr>
<th>Regulatory Compliance</th>
<th>Directive(s)</th>
<th>Notes</th>
</tr>
</thead>
</table>
### Applicable EU Directives for the MediaDirector 2201, 2202, 2251, 2252, and the MediaCenter:

<table>
<thead>
<tr>
<th>Regulatory Compliance</th>
<th>Directive(s)</th>
<th>Notes</th>
</tr>
</thead>
</table>
| CE                    | **Low Voltage Directive is 2006/95/EC,**  
|                       | **EMC directive is: 2004/108/EC**                                                                                                             | **EN 60950-1**  
|                       | **Safety of Information Technology Equipment**                                                                                               |                                            |
| EMC                   | **FCC Part 15 Class A**  
|                       | **ICES-003**  
|                       | **VCCI Class A**  
|                       | **CISPR 22 Class A**  
|                       | **CNS 13438**  
|                       | **EN 55022 Class A**  
|                       | **KN22 Class A**                                                                                                                              | **USA**  
|                       |                                                                                                                                             | **Canada**  
|                       |                                                                                                                                             | **Japan**  
|                       |                                                                                                                                             | **Australia, New Zealand, EU**  
|                       |                                                                                                                                             | **Taiwan**  
|                       |                                                                                                                                             | **EU**  
|                       |                                                                                                                                             | **Korea** |
| Safety                | **UL 60950-1 First, Second Edition**                                                                                                        |                                            |
|                       | **CSA C22.2**                                                                                                                                |                                            |
Applicable EU Directives for MediaPort Series 5000, MediaPort 7000 Series, and ChannelPort:

<table>
<thead>
<tr>
<th>Regulatory Compliance</th>
<th>Directive(s)</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>MediaPort 5000 Series, MediaPort 7000 Series, and ChannelPort</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CE</td>
<td>Low Voltage Directive is: 2006/95/EC, EMC directive is: 2004/108/EC</td>
<td>EN60950-1 Safety of Information Technology Equipment</td>
</tr>
</tbody>
</table>

| **ChannelPort** | | |

Applicable EU Directives for the Ellipse1000 and 2000:

<table>
<thead>
<tr>
<th>Regulatory Compliance</th>
<th>Directive(s)</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>CE</td>
<td>Low Voltage Directive is: 2006/95/EC, EMC directive is: 2004/108/EC</td>
<td></td>
</tr>
<tr>
<td>EMC</td>
<td>EN55022, EN61000-3-2, EN61000-3-3 and EN55024, VCCI V-3, AS/NZS CISPR22, KN22 and KN24</td>
<td></td>
</tr>
<tr>
<td>Safety</td>
<td>EN60950-1, EN60525-1, EN60825-2, UL60950-1, CSA C22.2 No. 60950-1</td>
<td></td>
</tr>
</tbody>
</table>
Applicable EU Directives for the Electra 1000, 5000, 5400, and 9200 encoders:

<table>
<thead>
<tr>
<th>Regulatory Compliance</th>
<th>Directive(s)</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>CE</td>
<td>Low Voltage Directive is: 2006/95/EC, EMC directive is: 2004/108/EC</td>
<td></td>
</tr>
<tr>
<td>EMC</td>
<td>EN55022, EN61000-3-2, EN61000-3-3 and EN55024. VCCI V-3, AS/NZS CISPR22</td>
<td></td>
</tr>
<tr>
<td>Safety</td>
<td>EN60950-1, EN60525-1, EN60825-2, UL60950-1, CSA C22.2 No. 60950-1</td>
<td></td>
</tr>
</tbody>
</table>

Applicable EU Directives for the Electra 8000 encoders:

<table>
<thead>
<tr>
<th>Regulatory Compliance</th>
<th>Directive(s)</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>CE</td>
<td>Low Voltage Directive is: 2006/95/EC, EMC directive is: 2004/108/EC</td>
<td></td>
</tr>
<tr>
<td>EMC</td>
<td>EN55022, EN61000-3-2, EN61000-3-3 and EN55024. VCCI V-3, AS/NZS CISPR22, KN22 and KN24</td>
<td></td>
</tr>
<tr>
<td>Safety</td>
<td>EN60950-1, EN60525-1, EN60825-2, UL60950-1, CSA C22.2 No. 60950-1</td>
<td></td>
</tr>
</tbody>
</table>

Applicable EU Directives for the ION AVC HD, ION AVC SD, ION MPEG-2, ION MPEG-4 AVC, and ION Multichannel encoders:

<table>
<thead>
<tr>
<th>Regulatory Compliance</th>
<th>Directive(s)</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>CE</td>
<td>Low Voltage Directive is: 2006/95/EC, EMC directive is: 2004/108/EC</td>
<td></td>
</tr>
<tr>
<td>EMC</td>
<td>EN55022, EN61000-3-2, EN61000-3-3 and EN55024. VCCI V-3, AS/NZS CISPR22</td>
<td></td>
</tr>
<tr>
<td>Safety</td>
<td>EN60950-1, EN60525-1, EN60825-2, UL60950-1, CSA C22.2 No. 60950-1</td>
<td></td>
</tr>
</tbody>
</table>
Applicable EU Directives for ProStream 1000, 2000, 4000, 4500, 5000, and 8000:

<table>
<thead>
<tr>
<th>Regulatory Compliance</th>
<th>Directive(s)</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>CE</td>
<td>Low Voltage Directive is: 2006/95/EC, EMC directive is: 2004/108/EC</td>
<td></td>
</tr>
<tr>
<td>EMC</td>
<td>EN55022, EN61000-3-2, EN61000-3-3 and EN55024. VCCI V-3, AS/NZS CISPR22</td>
<td></td>
</tr>
<tr>
<td>Safety</td>
<td>EN60950-1, EN60525-1, EN60825-2, UL60950-1, CSA C22.2 No. 60950-1</td>
<td></td>
</tr>
</tbody>
</table>

Applicable EU Directives for the MV400, MV450, and MV500 MPEG-2:

<table>
<thead>
<tr>
<th>Regulatory Compliance</th>
<th>Directive(s)</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>EMC</td>
<td>EN55022, EN61000-3-2, EN61000-3-3 and EN55024. VCCI V-3, AS/NZS CISPR22</td>
<td></td>
</tr>
<tr>
<td>Safety</td>
<td>EN60950-1, EN60525-1, EN60825-2, UL60950-1, CSA C22.2 No. 60950-1</td>
<td></td>
</tr>
</tbody>
</table>

**Important Safeguards and Notices**

This section provides important safety guidelines for both the Operator and Service Personnel. Specific warnings and cautions are found throughout the guide where they apply, but may not appear here. Please read and follow the important safety information, noting especially those instructions related to risk of fire, electric shock or injury to persons.

**Safety and Regulatory Information for the ContentServer 3000 and ContentStore 3160**

**Danger:** Class 1 laser product.

**Attention:** Produit laser de classe 1

**Warnung:** Laserprodukt der Klasse 1

This equipment contains optical transceivers, which comply with the limits of Class 1 laser radiation. Visible and invisible laser radiation may be emitted from the aperture of the optical transceiver ports when no cable is connected. Avoid exposure to laser radiation and do not stare into open apertures.
**Lithium Battery Notice for Service Personnel**

This product contains a lithium battery. Although the battery is not field-serviceable, observe the following warning:

<table>
<thead>
<tr>
<th>Mark</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>CAUTION: Danger of explosion if battery is replaced with incorrect type. Replace only with the same type recommended by the manufacturer. Dispose of used batteries according to the manufacturer’s instructions.</td>
<td></td>
</tr>
</tbody>
</table>

**WARNING:** CALIFORNIA PERCHLORATE ADVISORY
Some lithium batteries, may contain perchlorate material. The following advisory is provided: “Perchlorate Material – special handling may apply, see www.dtsc.ca.gov/hazardouswaste/perchlorate/” for information.

**ATTENTION:** Il y a danger d'explosion s'il a remplacement incorrect de la batterie. Remplacer uniquement avec une batterie du meme type ou d'un type equivalent recommande par le constructeur. Mettre au rebut les batteries usagées conformément aux instructions du fabricant

**WARNING:** Bei Einsetzen einer falschen Batterie besteht Explosionsgefahr. Ersetzen Sie die Batterie nur durch den gleichen oder vom Hersteller empfohlenen Batterietyp. Entsorgen Sie die benutzten Batterien nach den Anweisungen des Herstellers.

**WARNING:** This product relies on the building’s installation for short-circuit (overcurrent) protection. Ensure that a fuse or circuit breaker no larger than 120 VAC, 15A U.S. (240 VAC, 10A international) is used on the phase conductors (all current-carrying conductors).

**ATTENTION:** Pour ce qui est de la protection contre les courts-circuits (surtension), ce produit dépend de l’installation électrique du local. Vérifier qu’un fusible ou qu’un disjoncteur de 120 V alt., 15 A U.S. maximum (240 V alt., 10 A international) est utilisé sur les conducteurs de phase (conducteurs de charge).

**WARNING:** Dieses Produkt ist darauf angewiesen, daß im Gebäude ein Kurzschluß- bzw. Überstromschutz installiert ist. Stellen Sie sicher, daß eine Sicherung oder ein Unterbrecher von nicht mehr als 240 V Wechselstrom, 10 A (bzw. in den USA 120 V Wechselstrom, 15 A) an den Phasenleitern (allen stromführenden Leitern) verwendet wird.
### Important Safeguards and Notices

**WARNING**: To prevent bodily injury when mounting or servicing this unit in a rack, you must take special precautions to ensure that the system remains stable. These guidelines are provided to ensure your safety:

- This unit should be mounted at the bottom of the rack if it is the only unit in the rack.
- When mounting this unit in a partially filled rack, load the rack from the bottom to the top with the heaviest component at the bottom of the rack.
- If the rack is provided with stabilizing devices, install the stabilizers before mounting or servicing the unit in the rack.

**ATTENTION**: Pour éviter toute blessure corporelle pendant les opérations de montage ou de réparation de cette unité en casier, il convient de prendre des précautions spéciales afin de maintenir la stabilité du système. Les directives ci-dessous sont destinées à assurer la protection du personnel.

- Si cette unité constitue la seule unité montée en casier, elle doit être placée dans le bas.
- Si cette unité est montée dans un casier partiellement rempli, charger le casier de bas en haut en plaçant l'élément le plus lourd dans le bas.
- Si le casier est équipé de dispositifs stabilisateurs, installer les stabilisateurs avant de monter ou de réparer l'unité en casier.

**WARNUNG**: Zur Vermeidung von Körperversetzun beim Anbringen oder Warten dieser Einheit in einem Gestell müssen Sie besondere Vorkehrungen treffen, um sicherzustellen, daß das System stabil bleibt. Die folgenden Richtlinien sollen zur Gewährleistung Ihrer Sicherheit dienen:

- Wenn diese Einheit die einzige im Gestell ist, sollte sie unten im Gestell angebracht werden.
- Bei Anbringung dieser Einheit in einem Teil gefüllten Gestell ist das Gestell von unten nach oben zu laden, wobei das schwerste Bauteil unten im Gestell anzubringen ist.
- Wird das Gestell mit Stabilisierungszubehör geliefert, sind zuerst die Stabilisatoren zu installieren, bevor Sie die Einheit im Gestell anbringen oder sie warten.

The Technical File is available to proper authorities and the product is marked.
Safety Symbols

The product is marked with these symbols when it is necessary to refer to the manuals to prevent damage to the product.

<table>
<thead>
<tr>
<th>Symbol</th>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
</table>
| ![Caution Symbol] | Caution | Please observe the following important cautions:  
- When installing this equipment, always comply with the National Electrical Standard and local electrical standard for attachment of the power cords.  
- Risk of explosion if battery is replaced incorrectly or with an incorrect type. There are no user-serviceable batteries inside Omneon products. Refer to Omneon qualified personnel only to service the replaceable batteries. Dispose of batteries according to the instructions.  
- Use only specified replacement parts.  
- Follow static precautions at all times when handling this equipment.  
- Slots and openings in the chassis are provided for ventilation. Do not block them. Leave the back of the frame clear for air exhaust cooling and to allow room for cabling — a minimum of 6 inches (15.25 cm) of clearance is recommended.  
- Disconnect all AC power supplies when servicing any unit. |
| ![Warning Symbol] | Warning | Please observe the following important warnings:  
- Any instructions in this guide that require opening the chassis or removing a board should be performed by qualified service personnel only. To reduce the risk of electric shock, do not perform any servicing unless you are qualified to do so.  
- Heed all warnings on the unit and in the operating instructions.  
- Do not use this product in or near water. Disconnect all AC power before installing any options or servicing the unit unless instructed to do so by this manual.  
- This product is grounded through the power cord grounding conductor. To avoid electric shock, plug the power cord into a properly wired receptacle before connecting the product inputs or outputs. |
Appendix B Compliance, Safety, and Agency Approvals

Safety Precautions

To avoid injury and prevent equipment damage, observe the following safety precautions:

- Do not move or ship equipment unless it is correctly packed in its original wrapping and shipping containers.
- Only Harmonic trained personnel can undertake equipment service and maintenance.
- To prevent damage by lightning, ground the unit according to local regulations.
- Do not permit unqualified personnel to operate the unit.

AC Power Supply to the Unit

To ensure correctly and safely operation of the unit, the following are required:

- Adding to the system a UPS (Uninterrupted Power Supply) and an AVR (Automated Voltage Regulator) is highly recommended.

<table>
<thead>
<tr>
<th>Symbol</th>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
</table>
- Installing the main power supply by a qualified electrician, according to power authority regulations. Make sure all powering are wired with an earth leakage, according to local regulations.

- It is recommended to install the encoder within 1.5m (approximately 5 feet) from an easily accessible grounded AC outlet.

- When the encoder is rack-mounted, ensure that the rack is correctly grounded.

**DANGER:** To ensure that the rack is correctly grounded by a qualified electrician. Incorrectly grounded equipment may result in electrical shock.

**DC Power Supply to the Unit**

In the case the unit is fitted with DC power inputs, the following are required:

- Never work on DC powered equipment while power is applied. Disconnect power before making connections to the device.

- Ensure a suitable overcurrent device is inline between the equipment and the power source.

**Rack Mount Instructions**

- Elevated Operating Ambient: If installed in a closed or multi-unit rack assembly, the operating ambient temperature of the rack environment may be greater than room ambient temperature. Consideration should be given to installing the equipment in an environment compatible with the maximum ambient temperature (Tma) specified by the manufacturer.

- Reduced Air Flow: Installation of the equipment in a rack should be such that the amount of air flow required for safe operation of the equipment is not compromised.

- Mechanical Loading: Mounting of the equipment in the rack should be such that a hazardous condition is not achieved due to uneven mechanical loading.

- Circuit Overloading: Consideration should be given to the connection of the equipment to the supply circuit and the effect that overloading of the circuits might have on overcurrent protection and supply wiring. Appropriate consideration of equipment nameplate ratings should be used when addressing this concern.

- Reliable Earthing: Reliable earthing of rack-mounted equipment should be maintained. Particular attention should be given to supply connections other than direct connections to the branch circuit (e.g. use of power strips).

**Handling Fibre Channel Cables**

- Always read and comply with the handling instructions on the shipping container.

- Follow all ESD precautions and approved fiber cleaning procedures.

- The fiber is made of a very pure, expensive glass and should be treated with great care. Handle fibers only in areas that are very clean and do not contain sharp objects.

- Wear finger cots or gloves as dirt and oils can damage the fiber and contaminate connectors.

- Do not allow kinks or knots to develop in the fiber. If tangles occur, carefully work out the tangles avoiding pulling or bending the fibre beyond its bend radius.

- Always use the correct tools for stripping and cleaving the fiber. It will save time and reduce breakage caused by scratches.
- If you must secure a bundle of fiber cables together, avoid plastic and metal tie wraps; secure with velcro instead.

**Product End-of-Life Disassembly Instructions**

This section provides instruction for the disassembly of the indicated Harmonic Spectrum MediaDeck 7000 product family in order to remove components requiring selective treatment, as defined by the EU WEEE Directive (2002/96/EC).

<table>
<thead>
<tr>
<th>Description</th>
<th>Notes</th>
<th>Qty in the product</th>
<th>Location</th>
</tr>
</thead>
<tbody>
<tr>
<td>Printed Circuit Board Assemblies (PCBA) (PCBA)</td>
<td>With a surface greater than 10 sq. cm (Additional PCBA-s may be present depending on the configuration)</td>
<td>2</td>
<td>Inside the chassis</td>
</tr>
<tr>
<td>Batteries</td>
<td>All types including standard alkaline and lithium coin or button style batteries</td>
<td>1</td>
<td>LITHIUM COIN, P/N 57-1006 3V,20MM,2PIN on the main Base board. California USE Only: Perchlorate Material - For handling see: <a href="http://www.dtsc.ca.gov/hazardouswaste/perchlorate">www.dtsc.ca.gov/hazardouswaste/perchlorate</a></td>
</tr>
<tr>
<td>Mercury-containing components</td>
<td>For example, mercury in display backlights, switches, batteries</td>
<td>None</td>
<td>None</td>
</tr>
<tr>
<td>Liquid Crystal Displays (LCD) with a surface greater than 100 sq cm</td>
<td>Includes background illuminated displays</td>
<td>None</td>
<td>None</td>
</tr>
<tr>
<td>Video display device</td>
<td>With a screen size of more than 10 cm measured diagonally</td>
<td>None</td>
<td>None</td>
</tr>
<tr>
<td>Cathode Ray Tubes (CRT)</td>
<td>None</td>
<td>None</td>
<td>None</td>
</tr>
<tr>
<td>Capacitors / condensers (Containing PCB/PCT)</td>
<td>None</td>
<td>None</td>
<td>None</td>
</tr>
<tr>
<td>Electrolytic Capacitors / Condensers measuring greater than 2.5 cm in diameter or height</td>
<td>None</td>
<td>None</td>
<td>None</td>
</tr>
<tr>
<td>External electrical cables and cords</td>
<td>None</td>
<td>2</td>
<td>None</td>
</tr>
<tr>
<td>Gas Discharge Lamps</td>
<td>None</td>
<td></td>
<td>None</td>
</tr>
</tbody>
</table>
The following table lists the required tools.

<table>
<thead>
<tr>
<th>Description</th>
<th>Notes</th>
<th>Qty in the product</th>
<th>Location</th>
</tr>
</thead>
<tbody>
<tr>
<td>Philips screw drivers</td>
<td>#1 and #2</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Flat-head screw driver</td>
<td>small</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Flat-head screw driver</td>
<td>large</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Diagonal-cutting pliers, long-nose pliers</td>
<td>~5&quot;</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Sockets</td>
<td>11/32&quot;, 1/2&quot;, 5/8&quot;, and 9/16&quot; (deep)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Special tools to remove specific components</td>
<td>Not needed</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Product Disassembly Process**

1. Disassemble equipment at a dedicated area only, gather the needed tools for disassembly.
2. Remove covers, housing, etc.
3. Remove and separate subassemblies (i.e. lasers, cables, metals, displays, fans, etc.).
4. Separate hazardous materials from the remainder of the material.
   a. Sort hazardous materials into their different types (i.e., batteries, hazardous liquids, hazardous solids, fiberglass, etc.).
   b. Proceed with hazardous waste management processes only.
5. Identify re-usable materials/subassemblies and separate these from the rest of the material.
6. Identify and separate recyclable materials as per below examples:
   a. Scrap material to be sent to smelter(s).
   b. E-waste such as displays, CPU's, cables and wires, hard drives, keyboards, etc.
   c. Metals such as steel, brass, and aluminum.
   d. Plastics such as fan casings, housings, covers, etc.
e. Fiber optics and plastic tubing not containing electrical or data wiring.

Safety Rules

Recycler personnel are to wear personal protective equipment including proper eye protection, proper hand protection, and proper breathing protection if needed.

Recycler personnel shall be experienced with using the proper tools required for disassembling equipment. Untrained personnel shall not disassemble Harmonic products. Unfamiliarity with tools can cause damage and injury.